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บทที ่ 1  
บทน า 

 

1.1 ช่ือและทีต่ั้งของสถานประกอบการ 

 
 

รูปที ่1.1 แผนท่ีตั้งสถาประกอบการ 
 
ช่ือสถานประกอบการ : A-HOST Company Limited. 
ท่ีตั้งสถานประกอบการ : 979/53-55 SM Tower 21st Fl., Phaholyothin Rd., Samsennai, Phyatai, 
Bangkok10400 
Tel: 02-298-0625-32 Ext. 5309 
Fax: 02-298-0053 | Mobile: 081-835-4584 
 

1.2 ลกัษณะธุรกจิของสถานประกอบการ หรือการให้บริการหลกัขององค์กร 
  บริษทัเอ-โฮสตจ์  ากดัไดก่้อตั้งข้ึนเม่ือปีพ.ศ.2542 ในฐานะหน่ึงบริษทัในเครือของบริษทัซิสเตม็ส์

คอร์ปอเรชัน่ (มหาชน) จ ากดัและเป็นผูเ้ช่ียวชาญดา้นการบริการจดัวางระบบสารสนเทศ (Information 



2 
 

Technology : IT) และบริการเสริมต่างๆส าหรับลูกคา้ตั้งแต่ธุรกิจขนาดยอ่มไปจนถึงขนาดกลางธุรกิจ
หลกัของบริษทัเอ-โฮสต์คือการให้บริการโฮสต้ิง (Hosting) ซ่ึงเป็นการเปิดเคร่ืองคอมพิวเตอร์แม่ข่าย
ในการให้เช่าพื้นท่ีเพื่อวางระบบและบริการระบบสารสนเทศด้วยผลิตภณัฑ์ของออราเคิล (Oracle)    
เป็นซอฟตแ์วร์ส าหรับการวางแผนบริหารทรัพยากรของระดบัแนวหนา้ของโลก เอ-โฮสตถื์อก าเนิดข้ึน
จากกลุ่มผูเ้ช่ียวชาญด้านสารสนเทศท่ามกลางภาวะเศรษฐกิจตกต ่าทั่วภูมิภาคเอเชียแต่เอ-โฮสต์ก็
สามารถเติบโตอย่างรวดเร็วและมัน่คงตั้งแต่แรกก่อตั้งด้วยจุดแข็งในฐานะผูบุ้กเบิกธุรกิจโฮสติง
เซอร์วสิพร้อมทั้งน าธุรกิจแนวใหม่อยา่งการให้บริการระบบโปรแกรมประยุกตห์รือ ASP (Application 
Services Provider) เขา้มาให้บริการเป็นรายแรกในเมืองไทยอีกทั้งยงัถือเป็นผูใ้ห้บริการรายแรกนอก
ประเทศสหรัฐอเมริกาดว้ย 

 
  ในฐานะผูน้ าในอุตสาหกรรมน้ีเป็นเวลามากกวา่ 10 ปีเอ-โฮสตไ์ดเ้สริมสร้างความแขง็แกร่งทาง

ธุรกิจดว้ยบริการท่ีมีความโดดเด่นและรวบรวมเอาทรัพยากรบุคคลซ่ึงไดส้ั่งสมประสบการณ์และความ
ช านาญไวอ้ย่างพร้อมเพรียงส่งผลให้ศูนย์ข้อมูลของเอ-โฮสต์ในปัจจุบันมีความสมบูรณ์ด้วยกลุ่ม
เซิร์ฟเวอร์ (Server) ท่ีเช่ือมต่อกันในลักษณะการจัดกลุ่ม (Clustering) ซ่ึงเป่ียมสมรรถนะสามารถ
ใหบ้ริการแก่ผูใ้ชจ้  านวนมากไดใ้นเวลาเดียวกนั 

 
  นอกจากน้ีเอ-โฮสต์ยงัติดตั้งระบบรักษาความปลอดภยัระบบส ารองขอ้มูลและระบบบริหาร

จดัการรวมถึงอุปกรณ์ต่างๆอยา่งครบครันเพื่อให้เอ-โฮสตส์ามารถตอบสนองต่อระดบัความตอ้งการใน
ระดบัสูงสุดท่ีลูกคา้คาดหวงัไดต้ลอดจนเป็นการสร้างความมัน่ใจให้แก่ลูกคา้ท่ีใช้บริการโฮสติงและ
แอพพลิเคชนัต่างๆของเอ-โฮสตว์า่จะไดรั้บทั้งประสิทธิภาพและความปลอดภยัอยา่งครบครันธุรกิจการ
ให้บริการระบบโปรแกรมประยุกต์ในรูปแบบ ASP  เอ-โฮสต์ไม่เพียงแต่ให้บริการด้านโปรแกรม
ประยุกต์ดา้นการด าเนินธุรกิจทางอิเล็กทรอนิกส์ระดบัโลกของออราเคิลพร้อมโครงสร้างพื้นฐานทาง
เทคโนโลยีสารสนเทศเท่านั้นแต่ยงัมีบริการท่ีครอบคลุมตั้งแต่การให้ค  าปรึกษาการสนบัสนุนและการ
ใหบ้ริการทัว่ไปอยา่งพร่ังพร้อมครบครัน 

  
  นอกจากธุรกิจโฮสต้ิงและธุรกิจการให้บริการโปรแกรมประยุกต์ในรูปแบบ ASP ซ่ึงถือเป็น

ธุรกิจหลกัเอ-โฮสต์ยงัเดินหน้าธุรกิจอย่างต่อเน่ืองโดยการขยายหน่วยงานใหม่เพิ่มข้ึนนั่นก็คือ Core 
Technology Division หน่วยงานเทคโนโลยหีลกัท่ีใหค้  าตอบเบด็เสร็จแก่ลูกคา้ดว้ยระบบฐานขอ้มูลและ
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เคร่ืองมือต่างๆของออราเคิลซ่ึงช่วยเพิ่มความสามารถของลูกคา้ในการออกแบบพฒันาปรับเปล่ียน
ระบบแอพพลิเคชนัให้เหมาะสมกบัธุรกิจนั้นๆภายใตค้  าปรึกษาแนะน าและการวางระบบของเอ-โฮสต์
ลูกคา้สามารถบริหารระบบฐานขอ้มูลของตนเองและดูแลระบบดงักล่าวไดอ้ยา่งมีประสิทธิภาพ ตลอด
ระยะเวลามากกว่า10ปีในการด าเนินธุรกิจของเอ-โฮสต์ไม่เพียงแต่ในฐานะผูบุ้กเบิกธุรกิจโฮสติงและ
ธุรกิจการให้บริการโปรแกรมประยุกต์ในรูปแบบ ASP เท่านั้นแต่เอ-โฮสต์ยงัได้ท าการติดตั้งระบบ
สารสนเทศรวมทั้งผลิตภณัฑ์ของออราเคิลให้กบัลูกคา้จนประสบความส าเร็จเป็นจ านวนมากซ่ึงหลาย
รายเป็นหน่ึงในร้อยบริษทัชั้นน าของประเทศไทยแต่ส่ิงท่ีส าคญักว่านั้นก็คือการท่ีเอ-โฮสต์ได้สาน
สัมพนัธ์กบัลูกคา้และพนัธมิตรทางธุรกิจอยา่งแนบแน่นจนกลายเป็นหุ้นส่วนทางกลยุทธ์และไดรั้บตั้ง
แต่งใหเ้ป็น OCAP (Oracle Certified Advantage Partner) รายแรกในประเทศไทย 

 

 
 

รูปที ่1.2  รางวลัท่ีบริษทั A-HOST ไดรั้บ 
 

ปัจจุบนัเอ-โฮสตมี์ประเภทของสินคา้และการบริการซ่ึงสามารถแบ่งออกเป็น 3 กลุ่มใหญ่ไดแ้ก่ 
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1.2.1 Hosting & Outsource Service 

เอ-โฮสต์ได้ปรับปรุงและขยายการบริการ  Hosting และการให้บริการภายนอก  (Outsource) จน
สามารถครอบคลุมความตอ้งการของลูกคา้ไดอ้ยา่งหลากหลายโดยยึดหลกัในการในการให้บริการท่ีเรียกว่า 
“Peace of Mind for the customer” ซ่ึงหมายถึงการท่ีจะท างานให้กบัลูกคา้แบบครบวงจรเพื่อท่ีลูกคา้จะได้
สามารถใชง้านระบบสารสนเทศได้อยา่งมีประสิทธิภาพไดอ้ยา่งสบายใจไร้ความกงัวลต่อความเส่ียงต่างๆไม่
วา่จะเป็นเร่ืองของปัญหาทางเทคนิคการจดัท าระบบและขอ้มูลส ารองการปรับแต่งระบบใหไ้ดป้ระสิทธิภาพ
สูงสุด (Performance Tuning) และท่ีส าคญัท่ีสุดคือการท่ีเข้ามารับภาระในด้านการบริหารจดัการบุคลากร
ทางดา้นสารสนเทศทั้งหมดแทนลูกคา้ 

 
การใช้บริการ Hosting และ Outsource จะท าให้ลูกคา้สามารถทุ่มเทก าลงัสมองเวลาและทรัพยากร

ขององค์กรให้กบัธุรกิจท่ีเป็นแกนหลกั (Core Business) ซ่ึงเป็นส่ิงท่ีลูกคา้ถนัดกว่าโดยทัว่ไปแล้วบริการ 
Hosting และOutsource จะประกอบดว้ยส่วนประกอบและบริการยอ่ยๆดงัต่อไปน้ี 

1. High Availability and High Performance IT Infrastructure 
2. Dedicated or Co-Location Service 
3. Disaster Site 
4. Oracle E-Business Application (ERP, CRM, SCM) 
5. ERP Implementation Service 
6. System and Database Administration 
7. Help Desk 

8. On-Request Service i.e. On-Site Support, Software Customization 
 
ทั้งน้ีการบริการ Hosting และ Outsource สามารถครอบคลุมไดท้ั้งระบบท่ีใชเ้ทคโนโลยีของออรา

เคิลและระบบท่ีใชเ้ทคโนโลยอ่ืีนๆ 
 
1.2.2 Oracle Core Technology Products and Advanced Services 

เอ-โฮสต์เป็นผูน้ าในการด าเนินธุรกิจในฐานะผูแ้ทนจ าหน่ายเพิ่มมูลค่าให้กับออราเคิลโดยไม่
เพียงแต่ท าหนา้ท่ีในการจดัจ าหน่ายสินคา้ในกลุ่มแกนหลกัของเทคโนโลย ี(Core Technology) ของออราเคิล
ทุกประเภทแต่ยงัมีทีมผูเ้ช่ียวชาญท่ีจะให้การสนับสนุนและบริการเสริมอย่างครบวงจรแก่บริษทัคู่คา้และ
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ลูกคา้ไม่ว่าจะเป็นการร่วมจดักิจกรรมทางการตลาดการฝึกอบรมการติดตั้งระบบและการให้ค  าปรึกษาเพื่อ
แกไ้ขปัญหาต่างๆสินคา้และบริการท่ีอยู่ในกลุ่ม Oracle Core Technology Products and Advanced Services 
ไดแ้ก่ 

1. Oracle Database and database options 
2. Oracle Business Intelligence Suite 

3. Business Partner Development 
4. System Installation, Integration and Optimization 
5. Oracle Fusion Middleware (รวมถึง BEA) 
6. สินคา้อ่ืนๆทุกประเภทของออราเคิล 
7. Marketing and Lead Generation Activities 
8. SOA-Based Development and Implementation 
 
ผลส าเร็จในการด าเนินธุรกิจประเภทน้ีทั้งในดา้นการตลาดและบริการท าใหเ้อ-โฮสตไ์ดรั้บรางวลั 

ASEAN Partner of the Year ในปี 2005 
 
1.2.3 Oracle Enterprise Performance Management (EPM) และ Hyperion Business 
Intelligence Products and Services 

ความตอ้งการสูงสุดประการหน่ึงของผูบ้ริหารในการน าเอาระบบสารสนเทศมาใชใ้นองคก์รไม่วา่จะ
เป็นภาคราชการหรือเอกชนคือการท าให้ผูบ้ริหารสามารถไดข้อ้มูลท่ีแสดงให้เห็นถึงสถานะในการด าเนิน
ธุรกิจได้อย่างแม่นย  ารวดเร็วและการน าเอาขอ้มูลมาวิเคราะห์และวางแผนทั้งในระดบัปฏิบติัการและใน
ระดบักลยทุธ์เพื่อให้ธุรกิจสามารถไดเ้ปรียบในการแข่งขนัปรับตวัตามเศรษฐกิจไดใ้นทุกสถานการณ์ Oracle 
Enterprise Performance Management (EPM) และ Hyperion Business Intelligence จดัเป็นซอฟตแ์วร์ชั้นแนว
หนา้ของโลกท่ีสามารถสนองตอบต่อความตอ้งการในลกัษณะดงักล่าวไดเ้ป็นอยา่งดี 

 
เอ-โฮสตมี์ทีมงานท่ีปรึกษาท่ีมีประสบการณ์ทั้งทางดา้นธุรกิจและทางดา้นเทคนิครวมถึงความเขา้ใจใน

ระบบ ERP ของออราเคิลอย่างลึกซ้ึงจึงท าให้สามารถให้บริการท่ีปรึกษาเพื่อออกแบบติดตั้งเช่ือมโยงและ
ปรับใชร้ะบบให้กบัลูกคา้จนเกิดประสิทธิภาพสูงสุดอีกทั้งยงัมีความยืดหยุน่และให้การตอบสนองท่ีเร็วกวา่
เม่ือเทียบกบัการวา่จา้งท่ีปรึกษาจากต่างประเทศ 
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1.3 รูปแบบการจัดองค์กรและการบริหารองค์กร 
 

 
 

รูปที ่1.3 คณะผูบ้ริหาร A-HOST Company Limited 
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1.4 ต าแหน่งและหน้าทีง่านทีนั่กศึกษาได้รับมอบหมาย 
ต าแหน่ง : Programmer 
หน่วยงาน : BS 

KPI Description Expected Results 

1. พฒันา Web Application ดว้ย .NET 

Framework MVC5  C# และการจดัการ
ขอ้มูลดว้ย Entity Framework 

- สามารถพฒันาระบบท่ีสามารถใชง้านไดจ้ริง ถูกตอ้ง และเสร็จส้ินตาม
เวลาท่ีมอบหมาย 

- พฒันาโปรแกรมผา่นการทดสอบบนเคร่ือง UAT 

- (ท าเอกสาร Check List ) 

- สามารถช่วย Deploy Application บน Production ได ้

- ท าเอกสารส าหรับการพฒันาระบบเช่น Code Diff. หรือ programming 
flow 

- สามารถช่วยก าหนด test case ได ้

- จดัท าเอกสาร User Manual  

- จดัท าเอกสาร Programmer Manual 

2. ศึกษา .NET Core  - สามารถเปรียบเทียบขอ้ดีขอ้เสียระหวา่ง  
- ASP.NET Framework กบั ASP.NET Core 

- ศึ กษ าก าร  Migration จาก  ASP.NET to ASP.NET Core และส าม ารถ
น าไปใชง้านไดจ้ริง 

- ศึกษาการเรียกใช้  RESTFUL Web API ด้วย .NET Coreและสามารถ
น าไปใชง้านไดจ้ริง  

- สามารถแกไ้ขและปรับแต่ง เพื่อน าไปใชต่้อยอดได ้

- สามารถถ่ายทอดใหผู้อ่ื้นได ้

- จดัท าเอกสาร Programmer Manual ได ้
3. ท าหนา้ท่ีผูท้ดสอบระบบ ( Tester ) 

ใหก้บัระบบต่าง ๆท่ีเกิดข้ึนของ
แผนก 

- สามารถช่วยก าหนด Test case ได ้

- สามารถทดสอบระบบไดอ้ยา่งมีประสิทธิภาพ พร้อมทั้งบอกสาเหตุได้
อยา่งแม่นย  าในกรณีระบบมีปัญหา 

4. จดัท า Individual Work List - น าเสนอ INDIVIDUAL WORK LIST เป็นประจ าทุกเดือน 
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1.5 พนักงานทีป่รึกษา และ ต าแหน่งของพนักงานทีป่รึกษา 
- นาย ศุภวฒัน์ โพธิสมภพ 
- ต าแหน่ง : Programmer 
 

1.6 ระยะเวลาทีป่ฏบิัติงาน 
ระยะเวลาปฏิบติังานสหกิจศึกษาเป็นเวลา 4 เดือน 

- เร่ิมตน้ปฏิบติังานสหกิจศึกษา วนัท่ี 4 มิถุนายน 2561 

- ส้ินสุดงานสหกิจศึกษา วนัท่ี 26 กนัยายน 2561 

 

1.7 ทีม่าและความส าคญัของปัญหา 
ปัจจุบนัองค์กรทางธุรกิจส่วนใหญ่ตอ้งการระบบโครงสร้างการบริหารจดัการ เก่ียวกบัเทคโนโลยีท่ีดี

สามารถบรรลุความตอ้งการทางธุรกิจขององคก์ร ซ่ึงจะช่วยสร้าง ความพึงพอใจของลูกคา้ท่ีมีต่อองคก์รได้
เป็นอย่างดี ซ่ึงประเด็นท่ีส าคญัท่ีน่าจบัตาในการบริหารจดัการเทคโนโลยีสารสนเทศ คือ การพฒันาระบบ
ให้พร้อมให้บริการให้ตรงความตอ้งการและพร้อมท่ีจะเพิ่มประสิทธิภาพให้กบัการบริการให้ครอบคลุมกบั
ธุรกิจไดอ้ยา่งมากท่ีสุด 
 

1.8 วตัถุประสงค์หรือจุดมุ่งหมายของโครงงาน 
1. เพื่อศึกษาการและหาประสบการณ์การท างานจริงภายในองคก์ร 
2. เพื่อน าความรู้ท่ีไดไ้ปใชใ้นการพฒันาโครงงานและการท างานในอนาคต 

 

1.9 ผลทีค่าดว่าจะได้รับจากการปฏบิัติงานหรือโครงงานทีไ่ด้รับมอบหมาย 
1. นกัศึกษาน าความรู้ท่ีไดจ้ากการปฏิบติังานสหกิจไปใชป้ระกอบอาชีพ 
2. นกัศึกษาสามารถท างานร่วมกบัผูอ่ื้นไดเ้ป็นอยา่งดี 
3. นกัศึกษามีความรู้และทกัษะเฉพาะทางในสายงานน้ีมากยิง่ข้ึน 
4. นกัศึกษามีความรับผดิชอบในหนา้ท่ีการงานท่ีไดรั้บมอบหมาย 
5. นกัศึกษาสามารถท างานภายใตภ้าวะความกดดนัได ้
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1.10  นิยามศัพท์เฉพาะ 
Software: ชุดค าสั่งหรือโปรแกรมท่ีใชส้ั่งงานใหค้อมพิวเตอร์ท างาน 

Source Code: ชุดค าสั่งโปรแกรมโดยถูกเขียนดว้ยภาษาทางคอมพิวเตอร์ 

Compiler: การแปลภาษาคอมพิวเตอร์ท่ีเขียนข้ึนจากภาษาระดบัสูงใหอ้ยูใ่นรูปของภาษาระดบัต ่า 

Interpreter: การแปลภาษาคอมพิวเตอร์ทีละบรรทดั ส่วนใหญ่อยูใ่นรูปของภาษา Tag Script 

Framework: โปรแกรมส าหรับติดต่อระหวา่งระบบปฏิบติัการกบัภาษาระดบัสูง 

VM (Visual Machine): เคร่ืองคอมพิวเตอร์เสมือนอยูใ่นรูปดิจิตอล Software 

Binary: รูปแบบของระบบดิจิตอล ส าหรับค านวณ ซ่ึงมีลักษณะสัญญาณสูง ต ่ า อยู่ในรูป 0,1



  
 

บทที ่ 2  
ทฤษฎแีละเทคโนโลยทีีใ่ช้ในการปฏิบัตงิาน 

 

2.1 ดอตเน็ตเฟรมเวร์ิก (.NET Framework) 

แพลตฟอร์มส าหรับพัฒนาซอฟต์แวร์พัฒนาโดยไมโครซอฟท์ โดยรองรับระบบปฏิบัติการ  
Microsoft Windows เป็นหลกั ซ่ึงมีไลบรารีเป็นจ านวนมากส าหรับการเขียนโปรแกรม (Framework Class 
Library หรือ FCL) รวมถึงบริหารการด าเนินการของโปรแกรมบนดอตเน็ตเฟรมเวิร์ก โดยไลบรารีนั้นได้
รวมถึงส่วนต่อประสานกับผูใ้ช้ การเช่ือมต่อฐานข้อมูล วิทยาการเข้ารหัสลับ ขั้นตอนวิธี การเช่ือมต่อ
เครือข่ายคอมพิวเตอร์ และการพฒันาเวบ็แอปพลิเคชนั  

 
โปรแกรมท่ีเขียนบนดอตเน็ตเฟรมเวิร์ก จะท างานบนสภาพแวดล้อมท่ีบริหารโดย Common 

Language Runtime (CLR) ซ่ึงเป็นส่วนหน่ึงในดอตเน็ตเฟรมเวิร์ก โดย CLR นั้ นเตรียมสภาพแวดล้อม
เสมือน ท าให้ผูพ้ฒันาไม่ตอ้งค านึงถึงความสามารถท่ีแตกต่างระหว่างหน่วยประมวลผลต่างๆ และ CLR 
ยงัให้บริการด้านกลไกระบบความปลอดภยั การบริหารหน่วยความจ า และException handling ดอตเน็ต
เฟรมเวร์ิกนั้นออกแบบมาเพื่อใหก้ารพฒันาซอฟตแ์วร์ง่ายข้ึน รวดเร็วข้ึน และปลอดภยัข้ึนกวา่เดิม 
 

ดอตเน็ตเฟรมเวิร์ก(.NET Framework) เป็น .NET Platform ท่ีมีเป้าหมายในการพฒันาท างานบน 
mobile computing(Android และ IOS), embedded devices ,และขา้มระบบปฏิบติัการ(.NET Core) 
 

 
 

รูปที ่2.1 .NET Framework component stack 
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รูปที ่2.2 แสดงภาพรวมของ version .NET Framework 
 

2.1.1 สถาปัตยกรรม (Architecture) 
2.1.1.1 Common Language Infrastructure (CLI) 

CLI เป็ นข้อก าหนดห รือ  specification ท่ี ท าง  Microsoft พัฒ นาข้ึนมา ซ่ึ งก็ เป็ น  ตัว  .NET 
Technology เป็นมาตรฐาน ECMA-335 ท่ีจะท าให้ application ท่ีถูกพัฒนาจาก high level programming 
language ต่าง ๆ สามารถท างานไดบ้นระบบท่ีมี environment ต่างกนัหรือสามารถท างานบน platform ต่าง ๆ 
กนัไดโ้ดยเป็น ลกัษณะ Platform independent สามารถเขียนได้ด้วยภาษาต่าง ๆไดท่ี้รองรับหรือภาษาท่ีท า
ตาม specification ท่ี CLI ก าหนด หรือ เอาตามมาตรฐาน EMCA-335 CLI specification หรือ ข้อก าหนด 
CLI มีหลกั ๆ อยู ่4 อยา่ง คือ  

1. Common Type System (CTS) เก่ียวกับ type และ operations ท่ี  CTS-compliant (ภาษาต่าง ๆ) ใช้

ร่วมกนั CTS เช่น C#, C++, F#, Visual Basic, Others 

2. Metadata ก็คือข้อมูลต่าง ๆ ของโปรแกรม ซ่ึง CLI ใช้ในการอธิบายและอ้างอิง types ต่าง ๆ ท่ี 

ก าหนดใน CTS และก็จะถูกผนวกเขา้ใน assemblies ในระหวา่งท่ีท าการ compilation 

3. Common Language Specification (CLS) เป็นกฏพื้นฐาน ภาษาต่าง ๆ จะต้องท าตาม เพื่อท่ีภาษา

สามารถท างานร่วมกนัได ้
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4. Virtual Execution System (VES) เม่ือ ภาษาเหล่านั้น compile และได ้managed code ออกมา VES 

จะเป็นตวั execute ซ่ึงก็ใชข้อ้มูลต่าง ๆ ท่ีฝังมา (meta data)  

 

 
 

รูปที ่2.3 แสดงภาพรวมของโครงสร้างสถาปัตยกรรม CLI 
 

2.1.1.2 Common Language Runtime (CLR) 
เวอร์ชวลแมชีน (VM) ซ่ึงเป็นส่วนประกอบของดอตเน็ตเฟรมเวิร์ก และพฒันาตามมาตรฐานเปิด 

Common Language Infrastructure ท่ีไมโครซอฟทไ์ดพ้ฒันาข้ึนมา ซ่ึงอธิบายถึงสภาพแวดลอ้มส าหรับโคด้
ท่ีท างานบน CLR โดย CLR จะรันจากไบต์โค้ดท่ีเรียกว่า Microsoft Intermediate Language (MSIL) ซ่ึง
พฒันาตามมาตรฐาน Common Intermediate Language (CIL) 

 
ผู ้พ ัฒนาใช้ CLR ด้วยการเขียนโค้ดด้วยภาษาระดับสูงอย่าง C# หรือ VB.NET โดยช่วงเวลา

คอมไพล์ดอตเน็ตคอมไพเลอร์จะท าการแปลงโค้ดดังกล่าวไปเป็นโค้ด MSIL (Microsoft Intermediate 
Language) และเวลาท่ีรันโคด้ CLR's just-in-time compiler จะท าการแปลงโคด้ MSIL ไปเป็นภาษาเคร่ือง
ส าหรับระบบปฏิบัติการเพื่อให้ท างานได้ หรือหากต้องการโค้ด MSIL สามารถคอมไพล์ไปยงัเป็น
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ภาษาเคร่ืองก่อนท่ีจะรัน ก็ท าไดเ้ช่นกนั ซ่ึงในกรณีน้ีจะท าให้การรันโคด้ตอนแรกเร็วข้ึน เพราะไม่เสียเวลา
แปลงโคด้ MSIL ไปยงัภาษาเคร่ือง 

 

 
 

รูปที ่2.4 แสดงการแปลภาษา จาก CLI ไป CLR 
 

2.2 ดอตเน็ตคอร์ (.NET Core) 
เป็น Framework ท่ีถูกท าข้ึนใหม่และเป็น open source โดยใช้แบบจาก .NET Framework แต่ถูก

พฒันาข้ึนโดยค านึงถึงเร่ืองแยกส่วน .NET Core ท างานได้ทั้ง Windows, Linux และ OSX ถูกพฒันาให้มี
ประสิทธิภาพดียิง่ข้ึน 

 
.NET Core รองรับ cross-platforms ไดแ้ก่ ASP.NET Core, command-line apps, libraries, 

Universal Windows Platform apps (UWP) 
มี 3 ส่วนหลกั คือ  

1. Unified BCL เป็น API ท่ีใชร่้วมกนัไม่วา่จะพฒันา Windows Store App หรือ ASP.NET 5  

2. ASP.NET 5 เป็น framework ตวัใหม่ท่ีสามารถเลือกว่าจะใช้ท างานบน .NET Framework 

หรือ .NET Core  

3. Windows Store App เป็น framework ท่ีท างานบน .NET Core ใช้พัฒนา Windows Store 

(Universal Windows Platform – UWP) ได ้
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รูปที ่2.5 แสดงภาพรวมของโครงสร้างสถาปัตยกรรม .NET Core 
 

2.3 เอเอสพดีอตเน็ต (ASP.NET)  
เทคโนโลยีส าหรับพฒันาเวบ็ไซต ์เวบ็แอปพลิเคชนั และเวบ็เซอร์วิส ซ่ึงเป็นส่วนหน่ึงของดอตเน็ต

เฟรมเวร์ิก พฒันาโดยไมโครซอฟท์ เป็นรุ่นถดัจาก Active Server Pages (ASP) แมว้า่ ASP.NET นั้นจะใชช่ื้อ
เดิมจาก ASP แต่ทั้งสองเทคโนโลยีนั้นแตกต่างกนัอย่างส้ินเชิง โดยไมโครซอฟท์นั้นได้สร้าง ASP.NET 
ข้ึนมาใหม่หมดบนฐานจาก Common Language Runtime (CLR) ซ่ึงท าให้ผูพ้ฒันาสามารถเลือกใชภ้าษาใดก็
ไดท่ี้รองรับโดยดอตเน็ตเฟรมเวร์ิกเช่น C# และ VB.NET เป็นตน้ ซ่ึงรวมอยูใ่น .NET Framework 

 
2.4 เอเอสพดีอตเน็ตคอร์ (ASP.NET Core) 

เทคโนโลยีจากค่ายไมโครซอฟต ์(Microsoft) เพื่อใชส้ าหรับการพฒันาเวป็ไซต ์ทั้งน้ี ASP.NET Core 
สามารถพฒันาได้ทั้งระบบปฎิบติัการ Windows, Linux, Mac โดยภาษา C# และ Razor เป็น Open Source 
การเขียนโปรแกรมดงักล่าวใช้แนวคิดการเขียนโปรแกรมแบบ MVC (Model, View , Controller) ท่ีช่วยให้
ง่ายต่อการออกแบบ วิเคราะห์ และบ ารุงรักษา Web Application ส าหรับรุ่นปัจจุบนัของ .Net Core คือ .Net 
Core 2.1 
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2.5 Model-View-Controller (MVC) 

สถาปัตยกรรมซอฟแวร์ (software architecture) ท่ีมีการแบ่งแยกระบบออกเป็น 3 ส่วนหลกัๆ ไดแ้ก่ 
 

2.5.1 Controller  

เป็นส่วนท่ีท างานเป็นอนัดบัแรกเม่ือมีโปรแกรมถูกเรียก จาก Web browser เป็นส่วนท่ีติดต่อการ
ท างานระหวา่งผูใ้ชแ้ละโปรแกรม มีการติดต่อกบั Database(ฐานขอ้มูล) ดว้ย Model และแสดงผลขอ้มูลผา่น
ทาง View เป็นส่วนท่ีมีการประมวลผลหลกั ของโปรแกรม 
 
2.5.2 Model  

ดูแลในเร่ืองของการติดต่อส่ือสารระหวา่ง Object และ Database โดยท่ีผูพ้ฒันาไม่ตอ้งยุง่ยากกบัการ
ใช้ SQL command เป็นงานด้านการตรวจสอบความสัมพนัธ์ของข้อมูล มีผลกับฐานข้อมูล validation(
ตรวจสอบความถูกตอ้ง), association (ความสัมพนัธ์ระหวา่งฐานขอ้มูล) และอ่ืน ๆ 

 
2.5.3 View  

เป็นส่วนท่ีตอ้งแสดงผลผ่าน web browser เขียนด้วยพื้นฐานของ HTML การท างานสัมพนัธ์อยู่กบั 
controller และสนบัสนุน Ajax ,CSS, อ่ืน ๆ 

 

 
 

รูปที ่2.6 แสดงการความสัมพนัธ์ ระหวา่ง model view controller 



16 
 
2.6 ภาษาซีชาร์ป (C# Programming Language) 

เป็นภาษาโปรแกรมแบบหลายโมเดล ท่ีใช้ระบบชนิดขอ้มูลแบบรัดกุม (strong typing) และสนบัสนุน
การเขียนโปรแกรมเชิงค าสั่ง การเขียนโปรแกรมเชิงประกาศ Declare การเขียนโปรแกรมเชิงฟังก์ชนั การ
เขียนโปรแกรมเชิงกระบวนการ การเขียนโปรแกรมเชิงวตัถุ (แบบคลาส Class) และการเขียนโปรแกรมเชิง
ส่วนประกอบ พฒันาเร่ิมแรกโดยบริษทัไมโครซอฟท์เพื่อท างานบนดอตเน็ตเฟรมเวิร์ก โดยมีแอนเดอร์ 
เฮลส์เบิร์ก (Anders Hejlsberg) เป็นหวัหนา้โครงการ และมีรากฐานมาจากภาษาซีพลสัพลสั (C++)และภาษา
อ่ืน ๆ (โดยเฉพาะภาษาเดลไฟ Delphi และจาวา JAVA) โดยมีจุดมุ่งหมายใหเ้ป็นภาษาสมยัใหม่ท่ีไม่ซบัซอ้น 
ใชง้านไดท้ัว่ไป (general-purpose) และเป็นเชิงวตัถุเป็นหลกั 

 

 
 

รูปที ่2.7 ตวัอยา่งโปรแกรม HelloWorld ใน C# 
 

2.7 ADO.NET 

ADO.NET คือชุดส่วนประกอบซอฟต์แวร์เพื่อเขา้ถึงแหล่งขอ้มูลต่าง ๆ ซ่ึงเป็นส่วนหน่ึงในดอตเน็ต
เฟรมเวิร์ก แมว้า่ช่ือนั้นจะมาจากเทคโนโลยี ADO (ActiveX Data Object) แต่เน่ืองจากว่ามีการเปล่ียนแปลง
จากเดิมไปมากจนสามารถเรียกได้เป็นคนละผลิตภณัฑ์เลยทีเดียว โดยปกติแล้วจะใช้ในการเช่ือมต่อกับ
ฐานขอ้มูล  

 
2.7.1.1 Entity Framework 

ท าหนา้ท่ีจดัการ Database ร่วมกบัการเขียนอยู่ในรูปแบบของ Object/Relational Mapping (O/RM) 
คือ Entity Framework จะสร้าง Layer ท าหน้าท่ีเป็น Database Model ข้ึนมาเป็น Class ใน Projectโดยจะ 
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Mapping ตวั Class กับ Table , View และ Stored Procedure จาก Database โดยค าสั่ง DataSet, DataTable, 
DataReader, ExecuteNonQuery ท่ีใช้ จะท าหน้าท่ีแทนทั้ งหมดและให้เราเรียกใช้งาน Table ต่าง ๆ ผ่าน 
EntitySet ท่ีสร้างข้ึน ส่วนรูปแบบภาษา Syntax ท่ีจะใช้ ท างานแทนคือจะใช้ Syntax ของ LINQ ท างาน
ร่วมกบั Generic ของ List ซ่ึง LINQ น้ีจะมี Syntax ท่ีแตกต่างกบั SQL Statement ตามรูปแบบของภาษาเช่น 
VB.Net หรือ C# 

 
2.7.1.2 LINQ (Language Integrated Query)  

ภาษาสืบค้นข้อมูลใหม่LINQ ได้น ามาใช้ตงัแต่.NET Framework 3.5 ทีมากับภาษา VB และ C# 
ภาษาใหม่ทีคลา้ย SQL จึงมีคียเ์วิร์ด Select, From, Where, First, Max, Min ทีคอมไพล์เลอร์ของ VB และ C# 
เรียกใช้งานเมธอดจากคลาสใน .NET Framework ให้ถูกตอ้งตามชนิดของ LINQ เลือกใชก้บัแหล่งขอ้มูลท่ี
ติดต่อแบบใด ซึงมีอยูด่ว้ย 3 ประเภท คือ 

1. ขอ้มูลประเภท ออปเจก็ต ์พบอยูใ่นรูปคอลเล็กชนัต่างๆ เช่น Queue, Stack, Hashtable, 

SortList,ArrayList หรือคอลเล็กชนั แบบเจนเนอริก เช่น List<T>,IList<T>, ICollection<T>, 

Dictionary<T> และอ่ืน ๆ 

2. ข้อมูลประเภท ฐานข้อมูลเชิงสัมพันธ์ (Relational Database) เป็นข้อมูลพื้นฐานส าหรับงาน

ฐานขอ้มูลปัจจุบนัใชง้านกบั SQL 

3. ขอ้มูล XML ท่ีเปรียบไดด้งัขอ้มูลทีนิยามไดด้ว้ยตนเองตามความตอ้งการใชง้าน ทีมาตรฐานเปิดการ

ใชก้บั XMLดว้ย LINQ เรียกสันไดว้า่ LINQ to XML 

 
 

รูปที ่2.8 แสดงความสัมพนัธ์จาก SQL Server กบั LINQ 
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2.8 ไมโครซอฟท์ วชิวลสตูดิโอ (Microsoft Visual Studio) 

Integrated Development Environment (IDE) พฒันาข้ึนโดยไมโครซอฟท์ ซ่ึงเป็นเคร่ืองมือท่ีช่วย
นักพฒันาซอฟต์แวร์พฒันาโปรแกรมคอมพิวเตอร์ web sites , web apps ,web services และ mobile apps  
Visual Studio ใช้พฒันา platforms เช่น Windows API,Windows Forms,Windows Presentation Foundation, 
Windows Store และ Microsoft Silverlight รวมทั้ง native code และ managed code 

Visual Studio เป็ น  code editor ท่ี มี  Features  IntelliSense (ตัว ช่ วยในการตรวจ syntax) ,Code 
Refactoring, Integrated Debugger รวมทั้ งยงัมีการออกแบบ GUI, web designer ,การออกแบบ class และ 
การออกแบบ database schema รวมทั้งยงัรอบรับ Git และ NuGet รอบรับภาษาคอมพิวเตอร์ท่ีหลายหลาย
กว่า 36 ภาษา เช่น  C, C++, C++/CLI, Visual Basic .NET, C#, F#, JavaScript, TypeScript, XML, XSLT, 
HTML and CSS. ส าหรับภาษาอ่ืนๆ เช่น Python, Ruby, Node.js, and M among others is available via plug-
ins. Java (and J#) 
Visual Studio มีทั้งหมด 5 รุ่น Community, Professional, Enterprise, Test Professional, Express 

 

 
 

รูปที ่2.9 หนา้เร่ิมตน้ของ Visual Professional 2017 
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2.9  NuGet 

ตวัจดัการแพกเกจแบบเดียวกบั APT/Synoptics พฒันาข้ึนโดย Microsoft เพียงแต่อยู่ในรูปของ Visual 
Studio extension เอาไวจ้ดัการไลบรารีต่าง ๆ ท่ีเป็นโอเพนซอร์ส ร่วมกบัโครงการพฒันาท่ีเป็น .NET ซ่ึงเป็น 
Open-source 

 
2.10 jQuery 

jQuery คือ JavaScript Library ซ่ึงถูกออกแบบมาเพื่อให้การเขียน JavaScript นั้นมีความสะดวกและง่าย
ข้ึน เพราะว่าการน า JavaScript เอาไปประยุกต์กับงานจ าพวกเว็บ (Client-side JavaScript) นั้ นเป็นส่ิงท่ี
ยุง่ยาก ไม่วา่จะเป็นเร่ืองความไม่เขา้กนัของ Web Browser แต่ละค่าย, DOM หรือ API เป็นตน้   
            ดงันั้น jQuery จึงรวมเอา Object และ Function ต่าง ๆ ท่ีจ  าเป็นมารวบรวมไวใ้นรูปแบบของ Library 
ไม่ว่าโคด้ท่ีเขียนจะใช้ JavaScript  หลายบรรทดัขนาดไหน ก็สามารถท าให้สั้ นลงได้ อาจท าให้เหลือสั้ น
เพียงแค่บรรทัดเดียวเท่านั้ น  jQuery ประกอบด้วยฟีเจอร์ต่าง ๆ ดังน้ี HTML/DOM manipulation, CSS 
manipulation, HTML event methods, Effects and animations, AJAX, Utilities 
 
2.11 Bootstrap 

Frontend Framework ท่ีรวม HTML, CSS และ JS เข้าด้วยกันส าหรับพัฒนา Web ท่ีรองรับทุก 
Smart Device หรือ เรียกว่า Responsive Web หรือ Mobile First ถูกพฒันาข้ึนโดยทีมงานจาก Twitter หรือ 
Twitter.com  

Bootstrap พฒันาข้ึนมาเพื่อตอบโจทยใ์นด้าน Reponsive Web Design โดยเฉพาะซ่ึงมีระบบ Grid 
มาช่วย และมีการค านวนค่าหนา้จอพร้อมกบัปรับขนาดของ Web ใหแ้สดงผลกบัทุก ๆ หนา้จอโดยอตัโนมติั 
ซ่ึงเราสามารถปรับแต่งใหแ้ต่ละหนา้จอแสดงผลต่าง ๆ กนัได ้ตามขนาดของหนา้จอ 

 
2.12 HTML (Hypertext Markup Language) 

ภาษาหลกัท่ีใชใ้นการเขียนเวบ็เพจ โดยใช้ Tag ในการก าหนดการแสดงผล HTML ยอ่มาจากค าว่า 
Hypertext Markup Language โดย Hypertext หมายถึง ข้อความท่ีเช่ือมต่อกันผ่านล้ิง (Hyperlink) Markup 
language หมายถึงภาษาท่ีใช้ Tag ในการก าหนดการแสดงผลส่ิงต่างๆท่ีแสดงอยูบ่นเวบ็เพจ ดงันั้น HTML 
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จึงหมายถึง ภาษาท่ีใช้ Tag ในการก าหนดการแสดงผลเว็บเพจท่ีต่างก็เช่ือมถึงกันใน Hyperspace ผ่าน 
Hyperlink 

ความเป็นมาของ HTML เร่ิมข้ึนเม่ือปี 1980 เม่ือ Tim Berners Lee เสนอตน้แบบส าหรับนกัวิจยัใน 
CERN เพื่อแลกเปล่ียนเอกสาร ขอ้มูลดา้นการวิจยั โดยใชช่ื้อวา่ Enquire ในปี 1990 เคา้ไดเ้ขียนโปรแกรมเบ
ราเซอร์ และทดลองรันบนเซิฟเวอร์ท่ีเคา้พฒันาข้ึน HTML ไดรั้บการรู้จกัจาก HTML Tag ซ่ึงมีอยู่ 18 Tag 
ในปี 1991  

HTML ถูกพฒันาจาก SGML และ Tim ก็คิดเสมือนวา่ HTML เป็นโปรแกรมยอ่ยของ SGML อยูใ่น
ตอนนั้น ต่อมาในปี 1996 เพื่อก าหนดมาตรฐานให้ตรงกัน W3C World Wide Web Consortium จึงเป็นผู ้
ก  าหนดสเปกทั้ งหมดของ HTML และปี 1999 HTML 4.01 ก็ถือก าเนิดข้ึน โดยมี HTML 5 ซ่ึงเป็น Web 
Hypertext Application ถูกพัฒนาต่อมาในปี 2004 นอกจากน้ีย ังมีการพัฒนาไปเป็น XHTML ซ่ึ ง คือ 
Extended HTML ซ่ึงมีความสามารถและมาตรฐานท่ีรัดกุมกวา่ โดยอยูภ่ายใตก้ารควบคุมของ W3C (World 
Wide Web Consortium) 

 
2.13 CSS (Cascading Style Sheet) 

ภาษาท่ีใชเ้ป็นส่วนของการจดัรูปแบบการแสดงผลเอกสาร  HTML โดยท่ี CSS ก าหนดกฎเกณฑใ์น
การระบุรูปแบบ (หรือ "Style") ของเน้ือหาในเอกสาร อนัไดแ้ก่ สีของขอ้ความ สีพื้นหลงั ประเภทตวัอกัษร 
และการจดัวางขอ้ความ ซ่ึงการก าหนดรูปแบบ หรือ Style น้ีใชห้ลกัการของการแยกเน้ือหาเอกสาร HTML 
ออกจากค าสั่งท่ีใช้ในการจดัรูปแบบการแสดงผล ก าหนดให้รูปแบบของการแสดงผลเอกสาร ไม่ข้ึนอยูก่บั
เน้ือหาของเอกสาร เพื่อใหง่้ายต่อการจดัรูปแบบการแสดงผลลพัธ์ของเอกสาร HTML โดยเฉพาะในกรณีท่ีมี
การเปล่ียนแปลงเน้ือหาเอกสารบ่อยคร้ัง หรือต้องการควบคุมให้รูปแบบการแสดงผลเอกสาร HTML มี
ลกัษณะของความสม ่าเสมอทัว่กนัทุกหน้าเอกสารภายในเว็บไซต์เดียวกัน โดยกฎเกณฑ์ในการก าหนด
รูปแบบ (Style) เอกสาร HTML ถูกเพิ่มเขา้มาคร้ังแรกใน HTML 4.0  เม่ือปีพ.ศ. 2539 ในรูปแบบของ CSS 
level 1 Recommendations ท่ีก าหนดโดย องคก์ร World Wide Web Consortium หรือ W3C 

 
2.14 AJAX (Asynchronous JavaScript and XML) 

เป็นกลุ่มของเทคนิคในการพฒันาเวบ็แอปพลิเคชนัเพื่อใหค้วามสามารถโตต้อบกบัผูใ้ชไ้ดดี้ข้ึน โดย
การรับส่งขอ้มูลในฉากหลงั ท าให้ทั้งหน้าไม่ตอ้งโหลดใหม่ทุกคร้ังท่ีมีการเปล่ียนแปลง ซ่ึงช่วยท าให้เพิ่ม
การตอบสนอง ความรวดเร็ว และการใชง้านโดยรวม 
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เอแจ็กซ์นั้นไม่ใช่เทคโนโลยีใหม่ แต่เป็นเทคนิคท่ีได้ใช้เทคโนโลยีหลายอย่างท่ีมีอยู่แลว้รวมกนั
ดงัต่อไปน้ี 

 
2.14.1 XHTML (Extensible Hypertext Markup Language) 

เป็นภาษามาร์กอปัท่ีมีลกัษณะการใช้งานเหมือน HTML แต่จะมีความเขม้งวดในเร่ืองโครงสร้าง
ภาษา โดยมีวากยสัมพนัธ์สอดคล้องกบั XML เน่ืองจาก HTML นั้นใช้โครงสร้างของ SGML ท่ีค่อนขา้ง
ยืดหยุ่น ในขณะท่ี XHTML นั้นพฒันาจาก XML ซ่ึงเป็นภาษาท่ีคล้ายกบั SGML แต่เข้มงวดมากกว่า เรา
สามารถมองวา่ XHTML เป็นการแปลง HTML เดิมใหม้าอยูใ่นโครงสร้างของ XML ก็ได ้ 

XHTML 1.0 ได้ เข้าม าเป็ น ส่ วนห น่ึ งของ World Wide Web Consortium (W3C) ในวัน ท่ี  26 
มกราคม พ.ศ. 2543 และกลายมาเป็น W3C recommendation เม่ือ 31 พฤษภาคม พ.ศ. 2544 อย่างไรก็ตาม 
XHTML 2.0 จะหยดุภายในส้ินปี 2552 โดยหวงัจะพฒันา HTML 5 แทนท่ี 

 
2.14.2 ECMAScript 

เป็นภาษาสคริปต ์ ซ่ึงก าหนดมาตรฐานโดย Ecma International ดว้ยขอ้ก าหนดทางเทคนิค ECMA-
262 ภาษา ECMAScript นิยมใชแ้พร่หลายในการท าเวบ็ และมกัสับสนกบั JavaScript หรือ JScript ซ่ึงภาษา
ทั้งสองส าเนียงลว้นเป็นส่วนหน่ึงของมาตรฐาน ECMAScript 

 
2.14.3 XMLHttpRequest (XHR) 

เป็นเอพีไอท่ีสามารถเรียกใชไ้ดจ้าก จาวาสคริปต ์เจสคริปต ์วีบีสคริปต ์และภาษาสคริปตอ่ื์น ๆ ใน
การแลกเปล่ียน และปรับรูปแบบ XML จากเวบ็เซิร์ฟเวอร์ โดยใช้ HTTP ซ่ึงสร้างการเช่ือมต่อระหวา่งเวบ็
เบราวเ์ซอร์ (Client-Side) กบั เวบ็เซิร์ฟเวอร์ (Server-Side) 

 
2.14.4 รูปแบบข้อมูล XML 

ใชเ้ป็นรูปแบบขอ้มูลในการแลกเปล่ียน ซ่ึงรูปแบบอ่ืนก็สามารถใชไ้ดเ้ช่นกนัไม่ว่าจะเป็น HTML, 
JSON, EBML, หรือ ขอ้ความธรรมดา 
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2.15 JSON (JavaScript Object Notation) 

เป็นฟอร์แมตส าหรับแลกเปล่ียนขอ้มูลคอมพิวเตอร์ ฟอร์แมต JSON นั้นอยูใ่นรูปขอ้ความธรรมดา 
(plain text) ท่ีทั้งมนุษยแ์ละโปรแกรมคอมพิวเตอร์สามารถอ่านเขา้ใจได ้

มาตรฐานของฟอร์แมต JSON คือ RFC 4627 มี Internet media type เป็น application/json และมี
นามสกุลของไฟลเ์ป็น .json 

ปัจจุบนั JSON นิยมใชใ้นเวบ็แอปพลิเคชนั โดยเฉพาะ AJAX โดย JSON เป็นฟอร์แมตทางเลือกใน
การส่งขอ้มูล นอกเหนือไปจาก XML ซ่ึงนิยมใชก้นัอยูแ่ต่เดิม สาเหตุท่ี JSON เร่ิมไดรั้บความนิยมเป็นเพราะ
กระชบัและเขา้ใจง่ายกวา่ XML 

เจสัน เป็นรูปแบบสายอกัขระ (String) ชนิดหน่ึงท่ีถูกจดัเก็บในรูปแบบท่ีสามารถอ่านและเขา้ใจได้
ง่าย ถา้จะให้เขา้ใจง่าย ๆ ก็คือเจสันเปรียบเสมือนรูปแบบของ อาเรย ์(Array) ชนิดหน่ึงท่ีใชรั้บส่งขอ้มูลผา่น
อาแจ็กซ์เพราะซ่ึงปกติแลว้ถา้เราตอ้งการรับ-ส่งขอ้มูลผา่นอาแจ็กซ์ต่าง ๆ นั้น จะตอ้งรับ-ส่งมาในรูปแบบ
ของสายอกัขระทั้งกอ้น และเม่ือฝ่ังอาแจ็กซ์ท าการรับค่าท่ีท าการส่งค่ากลบัมาจากเซิร์ฟเวอร์ ก็จะตอ้งน าสาย
อกัขระ เหล่านั้นมาตัดต าแหน่งท่ีต้องการ เพื่อเอาสายอกัขระตัวท่ีต้องการมาใช้ แต่ส าหรับเจสันแล้ว 
สามารถรับส่งชุดค่าตวัแปรไดท้ั้งฝ่ังไคลเอนต์ (Client) และฝ่ังเซิร์ฟเวอร์ (Server) โดยทั้ง 2 ฝ่ังสามารถท า
การเขา้รหสัและถอดรหสัโดยใชเ้จสันเอนโคด้ (Json Encode) และ เจสันดีโคด้ (Json Decode) เพื่ออ่านค่าตวั
แปรเหล่านั้น และจะเรียกใชง้านมนัไดอ้ยา่งไร ซ่ึงปกติแลว้จะอยูใ่นรูปแบบของอาเรยแ์ละส าหรับตวัแปรเจ
สันนั้นไม่จ  ากดัแค่รับส่งขอ้มูลผ่านเวบ็เบราวเ์ซอร์เท่านั้น แต่ยงัสามารถน าเจสันไปประยุกต์กบัการรับส่ง
ขอ้มูลในรูปแบบอ่ืน ๆ ได ้เช่นการจดัเก็บขอ้มูลในรูปแบบของสายอกัขระในขอ้ความหรือการรับส่งผา่นตวั
ใหบ้ริการเวบ็ไซต ์(Web Service) ก็สามารถท าไดเ้ช่นเดียวกนั 

 

 
 

รูปที ่2.10 แสดงโครงสร้างการจดัการขอ้มูล json 
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2.16 XML (Extensible Markup Language) 

เป็นภาษามาร์กอปัส าหรับการใช้งานทัว่ไป พฒันาโดยW3C โดยมีจุดประสงค์เพื่อเป็น ส่ิงท่ีเอาไว้
ติดต่อกนัในระบบท่ีมีความแตกต่างกนั (เช่นใช้คอมพิวเตอร์ม่ีมีระบบปฏิบติัการคนละตวั หรืออาจจะเป็น
คนละโปรแกรมประยุกต์ท่ีมีความตอ้งการส่ือสารขอ้มูลถึงกนั) นอกจากน้ียงัเพื่อเป็นพื้นฐานในการสร้าง
ภาษามาร์กอปัเฉพาะทางอีกขั้นหน่ึง XML พฒันามาจาก SGML โดยดดัแปลงให้มีความซับซ้อนลดนอ้ยลง 
XML ใช้ในแลกเปล่ียนขอ้มูลระหว่างเคร่ืองคอมพิวเตอร์ท่ีแตกต่างกนั และเน้นการแลกเปล่ียนขอ้มูลผ่าน
อินเทอร์เน็ต 

 
Xml เป็นภาษาท่ีใชเ้นน้ (มาร์กอปั) ส่วนท่ีเป็นขอ้มูล โดยสามารถก าหนดช่ือแทก็ (Element) และช่ือ

แอตทิบิวต์ ได้ตามความตอ้งการของผูส้ร้างเอกสาร xml โดยเอกสารนั้นจะตอ้งมีความเป็น Well-formed 
ส่วน DTD และ Schema จะมีหรือไม่มีก็ได ้ข้ึนอยู่กบัว่ามีผูใ้ช้เอกสารนั้นมากน้อยแค่ไหน เอกสาร xml จึง
เป็นแค่เท็กซ์ไฟลช์นิดหน่ึง ท่ีมีแทก็เปิดและเทก็ปิดครอบขอ้มูลไวต้รงกลางเท่านั้น ท าให้เอกสาร xml ถูกใช้
ในการติดต่อกบัระบบท่ีต่างกนั เน่ืองจากความง่ายในการสร้างเอกสาร การน าเอกสาร xml ไปใช้งาน จะ
สนใจแต่ขอ้มูลท่ีถูกเนน้ดว้ยแทก็ 

 
Well-formed เป็นไวยากรณ์พื้นฐานของเอกสาร xml อยา่งเช่น เอกสาร xml ตอ้งเร่ิมตน้ดว้ย <?xml 

version="1.0" ?> เอกสาร xml 1 เอกสาร จะตอ้งมีแท็กรูทเพียงแท็กเดียว หมายความวา่ แท็กและขอ้มูลต่าง 
ๆ จะตอ้งอยูภ่ายในแท็กแรกสุดเพียงแทก็เดียว การเปิดและปิดแทก็จะตอ้งไม่มีการคร่อมกนั เช่น <b>ตวัหนา
<i>และ</b>เอียง</i> จะไม่ Well-formed 

 
เน่ืองจากเอกสาร xml สามารถก าหนดช่ือแท็ก และช่ือแอตทิบิวต์ไดต้ามความตอ้งการของผูส้ร้าง

เอกสาร ท าให้ในการเน้นขอ้มูลใดขอ้มูลหน่ึง สามารถมีเอกสาร xml หลายรูปแบบ หากวา่เอกสาร xml นั้น 
ถูกน าไปใช้ติดต่อกบัระบบอ่ืน ๆ อาจท าให้ส่ือความหมายไม่ตรงกนั ดงันั้นจึงตอ้งมีการก าหนดรูปแบบท่ี
เป็นมาตรฐานข้ึน (ตกลงรูปแบบระหวา่งกนั) โดย DTD และ Schema จะเป็นตวัก าหนดวา่เอกสาร xml นั้น 
จะตอ้งมีแท็กอะไรบา้ง ภายในแท็กนั้นจะมีแท็ก แอตทิบิวต์ หรือขอ้มูลอะไรไดบ้า้ง โดย DTD จะต่างกบั 
Schema ตรงท่ี Schema เป็นเอกสาร xml 
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รูปที ่2.11 แสดงโครงสร้างการจดัการขอ้มูล xml 
 

2.17 จาวาสคริปต์ (JavaScript) 
เป็นภาษาสคริปต์ ที มีลักษณะการเขียนแบบโปรโตไทพ (Prototyped-based Programming) 

ส่วนมากใชใ้นหนา้เวบ็เพื่อประมวลผลขอ้มูลท่ีฝ่ังของผูใ้ชง้าน แต่ก็ยงัมีใชเ้พื่อเพิ่มเติมความสามารถในการ
เขียนสคริปตโ์ดยฝังอยูใ่นโปรแกรมอ่ืน ๆ 

 
บริษทัซันไมโครซิสเต็มส์เป็นเจา้ของเคร่ืองหมายการคา้ "JavaScript" โดยมนัถูกน าไปใช้ภายใต้

สัญญาอนุญาตเพื่อการพฒันาเทคโนโลยโีดย เน็ตสเคป และมูลนิธิมอซิล 
 
ปัจจุบนัมีการใช้จาวาสคริปต์ท่ีฝังอยูใ่นเวบ็เบราวเ์ซอร์ในหลายรูปแบบ เช่น ใช้เพื่อสร้างเน้ือหาท่ี

เปล่ียนแปลงเสมอภายในเวบ็เพจ, ใชเ้พื่อตรวจสอบความถูกตอ้งของขอ้มูลท่ีผูใ้ชก้รอกก่อนน าเขา้ระบบ, ใช้
เพื่อเขา้ถึงขอ้มูลท่ีอยูภ่ายใตโ้ครงสร้างแบบ Document Object Model (DOM)เป็นตน้ 

 
นอกจากน้ีจาวาสคริปตย์งัถูกฝังอยู่ในแอปพลิเคชนัต่าง ๆ นอกเหนือจากเวบ็เบราวเ์ซอร์ไดอี้กดว้ย 

โดยรวมแลว้จาวาสคริปต์ถูกใชเ้พื่อให้นกัพฒันาโปรแกรม สามารถเขียนสคริปตเ์พื่อสร้างคุณสมบติัพิเศษ
ต่าง ๆ เพิ่มเติมจากท่ีมีอยูบ่นแอปพลิเคชนัดงัเดิม 

 
โปรแกรมใด ๆ ท่ีสนับสนุนจาวาสคริปต์จะมีตวัขบัเคล่ือนจาวาสคริปต์ (JavaScript Engine) ของ

ตวัเอง เพื่อเรียกใชง้านโครงสร้างเชิงวตัถุของโปรแกรมหรือแอปพลิเคชนันั้น ๆ 
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รูปที ่1.12 แสดงตวัอยา่งการประกาศใชง้านตวัแปรใน JavaScript 
 

2.18 Microsoft SQL Server 
SQL Server ห รือ Microsoft SQL Server คือระบบจัดการฐานข้อมูล เชิ งสัมพัน ธ์  ( relational 

database management system หรือ RDBMS) ผลิตโดยบ ริษัท   Microsoft เป็นระบบฐานข้อ มูลแบบ 
Client/Server และรันอยู่บน Window NT ซ่ึงใช้ภาษา T-SQL ในการดึงเรียกข้อมูล ด้วยเหตุท่ีข้อมูลส่วน
ใหญ่ทั่วโลกเก็บไวใ้นเคร่ืองท่ีใช้ Microsoft Windows เป็น Operating System จึงท า ให้เป็นการง่ายต่อ 
Microsoft SQL ท่ีจะน า ขอ้มูลท่ีอยู่ในรูป Windows Based มาเก็บและประมวลผล และ ประกอบกบัการท่ี
ราคาถูกและหาง่าย จึงเป็นปัจจยัหลกัท่ีท า ให ้Microsoft SQL จึงเป็นระบบฐานขอ้มูลท่ีมกัจะถูกเลือกใช ้

 

 
 

รูปที ่2.13 แสดงการใชง้าน SQL Server ผา่น Management Studio 
 

2.18 ภาษา SQL (Structured Query Language) 
ภาษาทางด้านฐานข้อมูลท่ีสามารถสร้างและปฏิบัติการกับฐานข้อมูลแบบสัมพันธ์(Relational 

Database)โดยเฉพาะและเป็นภาษาท่ีมีลกัษณะคลา้ยกบัภาษาองักฤษภาษา SQL ถูกพฒันาข้ึนจากแนวคิดของ 
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Relational Calculus และ Relation Algebra เป็นหลกัภาษา SQL เร่ิมพฒันาคร้ังแรกโดยหน่วยงานAlmaden 
Research Center ของบริษทั IBM โดยมีช่ือเร่ิมแรกว่า “ซีเควล” (Sequel) ต่อมาได้เปล่ียนช่ือเป็น “เอสคิว
แอล” (SQL) หลงัจากนั้นภาษา SQL ไดถู้กน ามาพฒันาโดยผูผ้ลิตซอฟแวร์ดา้นระบบจดัการฐานขอ้มูลเชิง
สัมพนัธ์จนเป็นท่ีนิยมกนัอยา่งแพร่หลายในปัจจุบนัโดยผูผ้ลิตแต่ละรายก็พยายามท่ีจะพฒันาระบบจดัการ
ฐานขอ้มูลของตนให้มีลกัษณะเด่นเฉพาะข้ึนมาท าให้รูปแบบการใชค้าสั่ง SQL มีรูปแบบท่ีแตกต่างกนัไป
บา้งเช่น Oracle Access SQL Base ของ Sybase Ingres หรือ SQL Server ของ Microsoft  เป็นตน้ดงันั้นในปี
ค.ศ. 1986 ทางด้าน American National Standards Institute (ANSI) จึงได้ก าหนดมาตรฐานของ SQL ข้ึน
อยา่งไรก็ตามโปรแกรมฐานขอ้มูลท่ีขายในทอ้งตลาดไดข้ยาย SQL ออกไปจนเกินขอ้ก าหนดของ ANSI โดย
เพิ่มคุณสมบติัอ่ืน ๆท่ีคิดวา่เป็นประโยชน์เขา้ไปอีกแต่โดยหลกัทัว่ไปก็ยงัปฏิบติัตามมาตรฐานของ ANSI 

 

 
 

รูปที ่2.14 แสดงการใชง้านภาษา SQL ร่วมกบั PLSQL 
 



  
 

บทที ่3 
แผนงานการปฏิบัตงิานและขั้นตอนการด าเนินงาน 

 

3.1 แผนงานการฝึกงาน  
 

ตารางที ่3.1 แผนงานการฝึกงานระยะเวลา ตลอด 4 เดือน 

 

หวัขอ้งาน มิ.ย. ก.ค. ส.ค. ก.ย. 

1 ศึกษาการโครงสร้างระบบงาน ตวัโปรแกรม, 
Source Code ,Workflow ,Framework 

  

 

              

2 พฒันาระบบ Web App ASP.NET(.NET 
Framework, MVC, Entity Framework) 

                

2.1 ทดสอบระบบ (Unit Test)                 

2.2 พฒันาระบบ (Coding)                 

2.3 แกบ้คั (Debugging)                 

3 Research ASP.NET Core                  

3.1 Migration from ASP.NET 
Framework to ASP.NET Core 

                

3.2 จดัท าเอกสาร, คู่มือการใชง้าน                 

4 สนบัสนุน ช่วยเหลืองานใน Team อ่ืน ๆท่ี
ไดรั้บมอบหมาย 

                

5 จดัท ารายงานบนัทึกประจ าสัปดาห์ 
(INDIVIDUAL WORK LIST) ส าหรับประชุม
และความกา้วหนา้ของโปรเจค 
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3.2 รายละเอยีดทีนั่กศึกษาปฏบิัติในการฝึกงาน 
                  ในการปฏิบติัการสหกิจศึกษาในคร้ังน้ี ข้าพเจา้ได้มีโอกาสเข้ามาร่วมงานในแผนก Business 
Solution (BS) โดยแผนกน้ีเน้นการพัฒนาระบบตามความต้องการของลูกค้า โดยงานท่ีข้าพเจ้าได้รับ
มอบหมายหลกัๆมีดงัน้ี 
 
3.2.1 พฒันาระบบ E-custom Web application 

พฒันาระบบ E-custom Web application ลูกค้า ร่วมกับทีม ซ่ึงพฒันาข้ึนในรูปแบบของ Web 
Application ดว้ย ASP.NET (Framework) บนระบบปฏิบติัการ Windows ของบริษทั T Services (นามสมุติ) 

 
3.2.2 Research วธีิการ Migrate ASP.NET ไปยงั ASP.NET Core  

โดยแต่เดิมทางบริษัท  A-Host ได้พัฒนา Web App ASP.NET (Framework) ซ่ึ งท างานบน
ระบบปฏิบติัการ Windows เท่านั้น ซ้ึงทางบริษทัต้องการขยายขีดความสามารถ เพิ่มประสิทธิภาพ และ 
เทคโนโลยใีหม่จึงท าใหเ้กิดการ Research ข้ึนมา 

 
3.2.3 Support พฒันาระบบอ่ืน ๆ ตามทีไ่ด้รับมอบหมาย  
                   พฒันาระบบอ่ืน ๆ ตามท่ีไดรั้บมอบหมาย ทดสอบระบบ แกไ้ขขอ้ผิดพลาด และจดัท าเอกสาร 
คู่มือ Document Manual 
 

3.3 ขั้นตอนการด าเนินงานทีนั่กศึกษาปฏบิัติงาน 
3.3.1 ศึกษาภาพรวมของระบบงานทีจ่ะพฒันา 

เน่ืองดว้ยบริษทั T Services (นามสมุติ) เป็นผูใ้ห้บริการด าเนินธุรกิจในดา้นการให้บริการแลกเปล่ียนขอ้มูล
ทางอิเล็กทรอนิกส์  ในรูปแบบของ Value Added Network (VAN) โดยมีว ัตถุประสงค์หลักเพื่ อให้บริการ
แลกเปล่ียนขอ้มูลในระบบการขนส่งสินคา้ระหวา่งประเทศเป็นไปในลกัษณะ Completed Logistics และสามารถ
รองรับการขนส่งในรูปแบบของ Multi-Modal Transport ไดอ้ย่างสมบูรณ์ โดยเร่ิมตน้เขา้สู่กลุ่มผูใ้ช้งานกบักรม
ศุลกากรเพื่อให้ผูส่้งออก น าเขา้ ตวัแทน สามารถด าเนินพิธีการศุลกากรไดอ้ยา่งเกิดประสิทธิภาพสูงสุด โดยทาง
บริษทัไดมี้ระบบ e-Manifest ซ่ึงเป็นกระบวนการในการรายงานเรือเขา้ และยื่นบญัชีสินคา้ส าหรับการน าเขา้ทาง
เรือ ทางอิเล็กทรอนิกส์ เป็นกระบวนการส่วนหน่ึงของการน าเขา้ทางอิเล็กทรอนิกส์ โดยเรือท่ีเขา้มาในประเทศไทย
ทุกล าจะตอ้งแจง้ขอ้มูลการรายงานเรือเขา้, เจา้ของตูสิ้นคา้/เจา้ของสินคา้ท่ีมีสินคา้มากบัเรือล านั้น ๆ, บญัชีตูสิ้นคา้ 
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และแจง้บญัชีสินคา้ส าหรับเรือ (Cargo Manifest) ให้กรมศุลกากรทราบ โดยการส่งขอ้มูลทางอิเล็กทรอนิกส์ให้
กรมศุลกากร จะต้องส่งผ่าน VAN ในรูปแบบ ebXML ตามมาตรฐานท่ีกรมศุลกากรก าหนด พร้อมลงลายเซ็น
อิเล็กทรอนิกส์ทุกคร้ัง 

 

3.3.1.1 ข้ันตอนการจัดท าข้อมูล e-Manifest 

1. นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Vessel Schedule (Pre Arrival) โดยเป็นการ
แจง้ประมาณการเรือเขา้ ถา้เป็นเรือตูค้อนเทนเนอร์ให้ท าการส่งขอ้มูลล่วงหนา้ 1 เดือน ถา้เป็นเรือประเภท
อ่ืน ๆใหแ้จง้ล่วงหนา้ทนัทีท่ีทราบ โดยกรมศุลกากรจะตอบกลบั “เลขรับรายงานเรือเขา้” (Receive Control 
No) 

2. นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Vessel Schedule (Original) โดยเป็นการแจง้
ยนืยนัวนัเวลาเรือเขา้จริง โดยมีเวลาส่งขอ้มูลไม่นอ้ยกวา่ 24 ชัว่โมงก่อนเรือเขา้จริง 

3. นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Ship Agent Operator โดยมีเวลาส่งขอ้มูลไม่
นอ้ยกวา่ 24 ชัว่โมงก่อนเรือเขา้จริง 

4. นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Container List โดยมีเวลาส่งขอ้มูลไม่น้อย
กวา่ 6 ชัว่โมงก่อนเรือเขา้จริง 

5. เจา้ของตูสิ้นคา้/เจา้ของสินคา้ ท าการส่งขอ้มูล Master Sea Cargo Manifest โดยมีเวลาส่งขอ้มูลไม่นอ้ยกวา่ 
24 ชัว่โมงก่อนเรือเขา้จริง 

 
รูปที ่3.1 Overview Process 
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3.3.2 ศึกษาการใช้งานโปรแกรมทีจ่ าเป็นต่อการพฒันาระบบ 

ระบบน้ีพฒันาอยูใ่นรูปแบบของ Web Application ดว้ย ASP.NET โดยใช้ IDE Visual Studio Professional 2017 
โดยใช้ ภ าษ า  C# .NET ใน ก ารพัฒ น าเป็ นห ลั ก  โด ย  ใน ตั ว  Web App พัฒ น าโดยอ าศั ยห ลั ก ก ารของ 
Model ,View ,Controller (MVC) โดยแยกออกเป็นสัจส่วน โดยในโหมด View  จะใช้ ภาษา HTML, CSS, JAVA Script 
ในส่วน Controller จะใช ้C#.NET เป็นหลกั และในส่วน Model จะใช ้Entity Framework (EF) ใชง้านร่วมกบัภาษา LINQ 
โดยเช่ือม Database กบั Microsoft SQL Server 2017 และมีการใช ้Restful API, Bootstep, jQuery ,Data Tables ร่วมดว้ย 

 

3.3.3 ศึกษาโครงสร้างตัวระบบเดิม 

เน่ืองด้วยระบบมีการพัฒนาเป็นทีมมาก่อนซ่ึงถูกพฒันามาก่อนท่ีขา้พเจ้าจะเขา้มาร่วมในการพฒันาระบบ
เพิ่มเติมน้ี ท าใหต้อ้งศึกษารูปแบบการท างานของตวัโปรแกรมโครงสร้าง Object ,Class อ่ืน ๆโดยรวม 

 

3.3.4 พฒันาตัวระบบ E-CUSTOM WEB APPLICATION 

พัฒนาระบบเพิ่ม เติมในส่วน  Backend ของโมดูล CLIS Container List จัดการเอกสารข้อมูลบัญชีตู้
สินคา้,MMAN Master Sea Cargo Manifest จดัการเอกสารบญัชีสินคา้ทางเรือ, ในส่วนของการจดัการ น าเขา้ ส่งออก
สินค้า พร้อมกบั ออกเอกสาร Import ,Export ในรูปแบบต่าง ๆ อนัได้แก่ Excel ,Document ,PDF , Text File และ
พฒันาในส่วน อ่ืน ๆ ทัว่ไป ในส่วน Frontend แสดงขอ้มูล การแจง้เดือน และอ่ืน ๆ โดยเช่ือมต่อกบัฐานขอ้มูล พร้อม
กบัแกไ้ข Bug ขอ้ผดิพลาดภายในระบบ  

 

 
รูปที ่3.2 แสดงหนา้แรกของระบบเม่ือ login 
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3.3.5 Research การ Migrate ASP.NET ไปเป็น ASP.NET Core 

เน่ืองดว้ยทางบริษทั A-Host และภายในทีมพฒันาตอ้งการท่ีจะพฒันา Web Application ในรูปแบบใหม่  ซ่ึง
ทางบริษทัตอ้งการขยายขีดความสามารถ เพิ่มประสิทธิภาพ และ เทคโนโลยีใหม่จึงท าให้เกิดการ Research ข้ึนมา
โดยได้ท าการศึกษาข้อมูลเก่ียวกับ ASP.NET Core และท าตัวเบต้า ทดสอบว่าสามารถโยกยา้ยจาก ASP.NET 
จาก .NET Framework ไปยงั ASP.NET Core ได้หรือไม่? และต้องใช้อะไรบ้างในการโยกยา้ย พร้อมด้วยจดัท า
เอกสาร ตวัอยา่ง Source Code 

 

 
 

รูปที ่3.3 รูปตวัอยา่งแสดงหนา้โมดูล Manifest Schedule .NET Core 

 

3.3.6 สนับสนุน ช่วยเหลืองานใน Team อ่ืน ๆทีไ่ด้รับมอบหมาย 

 ช่วยสนบัสนุนตวังานในส่วนพฒันา Software โปรเจคอ่ืน ๆท่ีไดรั้บมอบหมาย 

 

3.3.7 จัดท าเอกสาร Documents 

จดัท าเอกสาร INDIVIDUAL WORK LIST ประจ าสัปดาห์ ,  manual คู่มือการใชง้าน Slide 
ส าหรับการน าเสนอ และอ่ืน ๆ ท่ีเก่ียวขอ้ง



  
 

บทที ่4 
สรุปผลการด าเนินงาน การวเิคราะห์และสรุปผลต่าง ๆ  

 

4.1 ขั้นตอนและผลการด าเนินงาน 
ในช่วงระยะเวลาส่ีเดือนของการปฏิบติังานสหกิจศึกษา ไดมี้การด าเนินการตั้งแต่เร่ิมตน้จนปัจจุบนัโดย

ในช่วงหน่ึงเดือนแรก ไดรั้บค าแนะน าจากพนกังานท่ีแผนก BS ของทางบริษทั A-HOST ให้ศึกษาภาพรวม
ของระบบงานท่ีจะพฒันาก่อนเร่ิมเขา้ร่วมปฏิบติังานและศึกษาการใช้งานโปรแกรมท่ีจ าเป็นต่อการพฒันา
ระบบเพื่อใหเ้ขา้ใจกระบวนการทางธุรกิจการท างานของระบบ 

 
เร่ิมปฏิบติังานจริง ทางพนกังานท่ีแผนก BS ของทางบริษทั A-HOST ให้ขา้พเร่ิมปฏิบติังานร่วมกบัทีม

โดยพฒันาระบบ E-custom Web application  ของทางบริษทั T Services (นามสมุติ) โดยได้พฒันาระบบ
หลกัๆอยู่ 2 Modules ไดแ้ก่ CLIS Container List , MMAN Master Sea Cargo Manifest บางส่วน,แก ้Debug 
ตามจุดต่าง ๆตามท่ีไดรั้บมอบหมาย 

 
หลงัจาก 2 เดือน ทางพนักงานท่ีแผนก BS ของทางบริษทั A-HOST ได้มอบหมายให้ขา้พเจา้ท าการ

Research ศึกษาเทคโนโลยีใหม่และทดลองวิธีการพัฒนา Web Application ด้วย MVC ASP.NET Core 
พร้อมกบัการจดัท า Document และ รายงานการปฏิบติังานประจ ารายสัปดาห์( INDIVIDUAL WORK LIST 
) พร้อมกบัการประชุม   

 
ส าหรับรายละเอียดยอ่ยการปฏิบติังานสหกิจระยะเวลา 4 เดือนมีรายละเอียดดงัน้ี 
 

4.1.1 ศึกษาภาพรวมของระบบงานทีจ่ะพฒันา 
เน่ืองด้วยบริษัท T Services (นามสมุติ) เป็นผู ้ให้บริการด าเนินธุรกิจในด้านการให้บริการ

แลกเปล่ียนขอ้มูลทางอิเล็กทรอนิกส์ ในรูปแบบของ Value Added Network (VAN) โดยมีวตัถุประสงคห์ลกั
เพื่อให้บริการแลกเปล่ียนขอ้มูลในระบบการขนส่งสินคา้ระหว่างประเทศเป็นไปในลกัษณะ Completed 
Logistics และสามารถรองรับการขนส่งในรูปแบบของ Multi-Modal Transport ไดอ้ยา่งสมบูรณ์ โดยเร่ิมตน้
เขา้สู่กลุ่มผูใ้ชง้านกบักรมศุลกากรเพื่อใหผู้ส่้งออก น าเขา้ ตวัแทน สามารถด าเนินพิธีการศุลกากรไดอ้ยา่งเกิด
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ประสิทธิภาพสูงสุด โดยทางบริษทัไดมี้ระบบ e-Manifest ซ่ึงเป็นกระบวนการในการรายงานเรือเขา้ และยื่น
บญัชีสินคา้ส าหรับการน าเข้าทางเรือ ทางอิเล็กทรอนิกส์ เป็นกระบวนการส่วนหน่ึงของการน าเข้าทาง
อิเล็กทรอนิกส์ โดยเรือท่ีเขา้มาในประเทศไทยทุกล าจะตอ้งแจง้ขอ้มูลการรายงานเรือเข้า, เจา้ของตูสิ้นคา้/
เจา้ของสินคา้ท่ีมีสินคา้มากบัเรือล านั้น ๆ, บญัชีตูสิ้นคา้ และแจง้บญัชีสินคา้ส าหรับเรือ (Cargo Manifest) ให้
กรมศุลกากรทราบ โดยการส่งขอ้มูลทางอิเล็กทรอนิกส์ให้กรมศุลกากร จะตอ้งส่งผ่าน VAN ในรูปแบบ 
ebXML ตามมาตรฐานท่ีกรมศุลกากรก าหนด พร้อมลงลายเซ็นอิเล็กทรอนิกส์ทุกคร้ัง 

 
4.1.1.1 ผู้เกีย่วข้องกบัระบบ 
- เจา้ของเรือ หรือ ตวัแทนสายเรือ 
- เจา้ของตูสิ้นคา้ หรือ เจา้ของสินคา้ 
- Freight Forwarder 

 
4.1.1.2 เอกสารที่เกีย่วข้องกบัระบบ 

- Vessel Schedule: เอกสารรายงานยานพาหนะเขา้/ออก 

- Ship Agent Operator: เอกสารบญัชีสินคา้ทางเรือส าหรับบริษทัเรือ หรือตวัแทนเรือ 

- Container List: เอกสารขอ้มูลบญัชีตูสิ้นคา้ 

- Master Sea Cargo Manifest: เอกสารบญัชีสินคา้ทางเรือ (Bill of Lading) 

- Cancel Manifest: เอกสารยกเลิกขอ้มูลบญัชีสินคา้ 

4.1.1.3 ข้ันตอนการจัดท าข้อมูล e-Manifest 

- นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Vessel Schedule (Pre Arrival) โดยเป็น

การแจง้ประมาณการเรือเขา้ ถา้เป็นเรือตูค้อนเทนเนอร์ให้ท าการส่งขอ้มูลล่วงหน้า 1 เดือน ถา้เป็นเรือ

ประเภทอ่ืน ๆให้แจง้ล่วงหน้าทันทีท่ีทราบ โดยกรมศุลกากรจะตอบกลับ “เลขรับรายงานเรือเข้า” 

(Receive Control No) 
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- นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Vessel Schedule (Original) โดยเป็นการ

แจง้ยนืยนัวนัเวลาเรือเขา้จริง โดยมีเวลาส่งขอ้มูลไม่นอ้ยกวา่ 24 ชัว่โมงก่อนเรือเขา้จริง 
- นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Ship Agent Operator โดยมีเวลาส่งขอ้มูล

ไม่นอ้ยกวา่ 24 ชัว่โมงก่อนเรือเขา้จริง 
- นายเรือหรือตวัแทนผูรั้บมอบอ านาจนายเรือ ท าการส่งขอ้มูล Container List โดยมีเวลาส่งขอ้มูลไม่นอ้ย

กวา่ 6 ชัว่โมงก่อนเรือเขา้จริง 
- เจา้ของตูสิ้นคา้/เจา้ของสินคา้ ท าการส่งขอ้มูล Master Sea Cargo Manifest โดยมีเวลาส่งขอ้มูลไม่น้อย

กวา่ 24 ชัว่โมงก่อนเรือเขา้จริง 
 

4.1.1.4 ผู้รับข้อมูล 
- กรมศุลกากร 
- การท่าเรือ (การท่าเรือ A,การท่าเรือ B,ท่าเรือเอกชน (ท่ีเขา้ร่วมโครงการ)* 
- กรมเจา้ท่า 
  

 
 

รูปที ่4.1 Overview Process 
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รูปที ่4.2 แสดงความตอ้งการใชข้อ้มูลเอกสารต่างๆ 
 
4.1.1.5 โครงสร้างข้อมูล Container List 

ขอ้มูลรายละเอียดตูสิ้นคา้ (Container) ตวัแทนเรือหรือผูท่ี้รับมอบอ านาจมีหนา้ท่ีในการจดัท าขอ้มูล 
 

 
 

รูปที ่4.3 แสดงโครงสร้างขอ้มูล Container List 
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4.1.2 ศึกษาการใช้งานโปรแกรมทีจ่ าเป็นต่อการพฒันาระบบ 

- ศึกษาการใชง้าน Visual Studio ในส่วนต่างๆ เช่น การ new project, create class, การใชง้านร่วมกนั
กบั Git, Repository,การ Debug อ่ืนๆ 

- ศึกษาการพัฒนา Web App ด้วย ASP.NET ในการพัฒนาโปรเจคและท างานร่วมกับทีม ได้แก่ 
HTML,CSS ,JAVASCRIPT,Lib ต่าง , MVC ,Controller ,View ,Model 

- ศึกษา Database การใช้งาน Microsoft SQL Server ในการจดัการ Database รวมทั้ งการใช้ค  าสั่ง 
SQL QUERY,SELECT,ADD,DELETE,ALTER,SEQ, การ BACKUP และ RESTORE 

- ศึกษาส่ิงอ่ืนๆท่ีเก่ียวขอ้ง ..เป็นตน้ 
 
4.1.3 พฒันาตัวระบบ E-CUSTOM WEB APPLICATION  

การพฒันาระบบไดถู้กแบ่งออกเป็น 3 แบบ ไดแ้ก่ 
 

4.1.3.1 New Requirement 
- พฒันาในส่วน MMAN Dropdown list Add Berth No.  

พฒันาในส่วน MMAN Dropdown list Add Berth No. ทั้งในฝ่ังขา ADD ,EDIT  
 

 
 

รูปที ่4.4 แสดงต าแหน่ง Dropdown List ท่ีพฒันา 
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- พฒันาในส่วนCLIS Import File 
พฒันาในส่วนCLIS Import File โดยไปท่ีปุ่ม Import File ซ่ึงมีอยู ่2 ท่ี คือ หน้า Index และ 

Edit โดยไฟล์ ท่ี  Import เข้าระบบ  Extension ได้แ ก่  XML,XLS,TXT เข้าสู่  ระบบ  : Database 
MSSQLServer 
 

 
 

รูปที ่4.5 แสดงต าแหน่งปุ่ม import หนา้ index 
 

 
 

รูปที ่4.6 แสดงต าแหน่งปุ่ม import หนา้ Edit 
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เม่ือเขา้มาหนา้ Index จะมีปุ่ม Import File เพื่อท าการ  Import น าขอ้มูลเขา้เพื่อท าการ Add 
ขอ้มูลเขา้ไปในระบบ ไฟลท่ี์น ามา Import ไดแ้ก่ XML,EXCEL(.xls),TEXTFILE(.txt) 

 

 
 

รูปที ่4.7 แสดงตวัอยา่ง ไฟล ์XML และ format ภายใน 
 

 
 

รูปที ่4.8 แสดงตวัอยา่ง ไฟล ์Excel (XLS) และ format ภายใน 
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รูปที ่4.9 แสดงตวัอยา่ง ไฟล ์Text (txt) และ format ภายใน 
 

- พฒันาในส่วน CLIS Export Excel (xls) 
พฒันาในส่วน CLIS Export Excel (xls) : เม่ือกด print document ออกมา จะ export ไฟลอ์ยูใ่น

รูปเอกสาร excel 
 

 
 

รูปที ่4.10 แสดงตวัอยา่ง export file xls 
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รูปที ่4.11 แสดงตวัอยา่ง fomat ภายใน file xls 
 

- พฒันาในส่วน GridLine  Crystal Report 
พฒันาในส่วน GridLine โดย export file ออกเป็น excel แต่ Crystal Reportไม่มี Gridline 

จึงท าการพิ่มเติมในส่วน gridline 
 

 
 

รูปที ่4.12 แสดงตวัอยา่งภายใน file ท่ี export ดว้ย crystal report 
 

- พฒันาในส่วน MMAN Warning Import Data Mismatch 
กรณีน้ีถา้ Import ขอ้มูล Container Operator ไม่ตรงกบั Master Data ในระบบ สามารถ 

import เขา้ระบบไดต้ามปกติ แต่ใหแ้สดงขอ้ความแจง้เตือนท่ีหนา้ index 
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รูปที ่4.13 แสดงตวัอยา่งการแจง้เตือนเม่ือ MasterData ไม่ตรงกบั Import เขา้มาในระบบ 
 

- พฒันาในส่วน MMAN Import : แจ้งว่ามี BL No. ซ ้าในไฟล์ Import 
กรณีน้ีถา้ Import แลว้พบวา่ไฟลท่ี์ น าเขา้มาไม่วา่จะเป็น xml ,xls, txt มี BL No. ซ ้ ากนั ให้

แสดง error ออกมา 
 

 
 

รูปที ่4.14 แสดงตวัอยา่งการแจง้เตือนเม่ือ BL No. ซ ้ ากนั 
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- พฒันาในส่วน CLIS Import : แจ้งว่ามี Container No. ซ ้าในไฟล์ Import 
กรณีน้ีถา้ Import แลว้พบวา่ไฟลท่ี์ น าเขา้มาไม่วา่จะเป็น xml ,xls, txt มี Con No. ซ ้ ากนั ให้

แสดง error ออกมา 
 

 
 

รูปที ่4.15 แสดงตวัอยา่งการแจง้เตือนเม่ือ Con No. ซ ้ ากนั 
 

- พฒันาในส่วน MMAN Detail: เพิม่ฟิลด์บอกจ านวนตู้คอนเทนเนอร์ 
เพิ่มฟิลดบ์อกจ านวนตูค้อนเทนเนอร์ โดยพฒันาทั้งในส่วนหนา้ view page และ ฝ่ัง 

controller โดยใช ้api Json ในการ render 
 

 
 

รูปที ่4.16 แสดงฟิลดบ์อกจ านวนตูค้อนเทนเนอร์ 
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- พฒันาในส่วน MMAN Detail : ปุ่มลดัไปเมนูสร้าง Master Customer 
เพิ่มปุ่มและ form หนา้ customer ท าให ้user สามารถเพิ่ม customer โดยไม่ตอ้งไปหนา้ 

Master Data ซ่ึงเพิ่มความสะดวกใหก้บั user มากข้ึนโดยอยูใ่นรูปของ modal boostap 
 

 
 

รูปที ่4.17  แสดง modal dialog ส าหรับเพิ่ม customer 
 
4.1.3.2 Fix Bug 

- ข้อมูลไม่บันทกึลง Database เม่ือ Import text 
- Alert box ไม่แสดงข้อความ 
- Notify show Import file successfully 
- Notify show refresh successfully 
- MMAN: กด cancel ข้อมูล Detail ไม่ได้ 
- MMAN: ลบข้อมูลส่วน Detail ไม่ได้ 
- MMAN: บันทึกข้อมูลส่วน header ไม่ได้ 
- CLIS: Import file ข้อมูล Ship Agent ไม่บันทกึ 
- CLIS: ฟิลด์ Con. Status ไม่แสดงข้อมูลตามที ่Import เข้าไป (Import Text) 
- CLIS: ฟิลด์ CLD_CON_AGENT_NAME ไม่ถูกบันทกึ (Import Text) 
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- CLIS: ฟิลด์ Container Operator และ Con. Status ไม่แสดงข้อมูลตามที ่Import เข้าไป (Import 
XML) 
 

4.1.3.3 Defect 
- ปรับปรุงข้อบกพร่องระบบ Area Code (Date Time) 

แถบเมนู Master Data TCD > Area Code พบ error เก่ียวกบั end date ซ่ึงพบปัญหาส าหรับ 
ค่า date timeเป็นปัญหาระหวา่งการดึงค่าแต่ละเคร่ืองซ่ึงไดแ้กไ้ขปัญหาโดยก าหนด format string 

 

 
 

รูปที ่4.18  แสดง error format string 
 

- ปรับปรุงข้อบกพร่องระบบ CLIS Detail : ฟิลด์ Con. Status ไม่แสดงข้อมูลตามที ่Import เข้าไป 
ปรับปรุงขอ้บกพร่องระบบ CLIS Detail Information : ฟิลด์ Container Operator, Branch, 

หน่วยนบั ไม่แสดงขอ้มูลตามท่ี Import เขา้ไป) 
 

 
 

รูปที ่4.19 แสดงจุดท่ีบกพร่องไม่แสดงขอ้มูล 
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- ปรับปรุงข้อบกพร่องระบบ CLIS Detail : เม่ือ Copy ข้อมูล Detail ไม่ Copy Rack มาด้วย 
เม่ือกดปุ่ม copy จะแสดงขอ้มูลให ้user จากนั้นค่อยท าการ copy 
 

 
 

รูปที ่4.20 แสดงปุ่ม copy ท่ี detail 
 

 
 

รูปที ่4.21  เม่ือกดปุ่ม copy แสดงหนา้ ขอ้มูลก่อน save  
 

แกไ้ขปัญหาโดยการ สร้าง procedure ข้ึนมาท าการ copy 
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รูปที ่4.22  แสดงตวัอยา่งบางส่วน procedure copy rack 
 

- ปรับปรุงข้อบกพร่องระบบ MMAN Copy Detail : เม่ือ Copy ข้อมูล Detail ไม่ Copy Container 
มาด้วย 

เม่ือท าการ copy ขอ้มูล detail mman ขอ้มูล ตู ้container ไม่มาดว้ย 
 

 
 

รูปที ่4.23  แสดงตวัอยา่ง copy Container แลว้ rack ไม่มา 
แกไ้ขดว้ยการใช ้procedure ช่วยในการ copy 
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รูปที ่4.24  แสดงตวัอยา่งบางส่วน procedure copy MMAN 
 

- ปรับปรุงข้อบกพร่องระบบ MMAN Import : Import โดยไม่มี Container ได้ 
ในส่วนของ Container No. หา้มวา่ง หากวา่งจะไม่สามารถ Import ได ้

 

 
 

รูปที ่4.25  แสดงตวัอยา่งบางส่วน format ภายใน file xls 
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4.1.4 Research การ Migrate ASP.NET ไปเป็น ASP.NET Core 
4.1.4.1 Migrate ASP.Net to ASP.NET Core ตัวทดสอบ 

 

 
 

รูปที ่4.26 แสดงการ Migrate จาก ASP.NET to ASP.NET Core 
 
เร่ิมตน้ สร้าง new project ใหม่ 

• new project asp.net core 2.1 
• Select ASP.NET Core Web Application 
• Project name <your project name> 
• Next step click OK 
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รูปที ่4.27  แสดงการสร้าง new project ใน Visual Studio2017  

• Select ASP.NET Core 2.1 
• Select Web Application (MVC) 
• Next step click OK 

 

 
 

รูปที ่4.28  แสดงการสร้าง new project เลือก MVC ใน Visual Studio2017  



50 
 

จะเห็นวา่ภายในโครงสร้างโปรเจคนั้นจะมีไฟลต่์อไปน้ี 
• Solution Explorer 

• wwwroot 
• CSS (contain file css style for style web) 
• Image(contain images,icons ,etc) 
• Js(contain JavaScript files) 
• Lib(others library ,bootstap,datatable,etc..) 

• Controller(control between model ,view) 
• Models(data model design on database) 
• Views(contain file HTML razor page..) 
• Appsettings.json(setting values app using json) 
• Program.cs(first start function main) 
• Startup.cs(config web, initial value etc..) 
• Dependencies (references lib from external project ,from NuGet) 

 
รูปที ่4.29 แสดงโครงสร้างภายในโปรเจค 

เช่ือมต่อกบัฐานขอ้มูลภายนอกท่ีมีอยูแ่ลว้ ในท่ีน้ีเช่ือมกบั Microsoft SQL Server 2017 
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• Connect Database Existing 
• In NuGet Package Manager Console follow this command 

• Install-Package Microsoft.EntityFrameworkCore.SqlServer 
• Install-Package Microsoft.EntityFrameworkCore.Tools 
• Install-Package Microsoft.VisualStudio.Web.CodeGeneration.Design 

• mapping database using command 
• Scaffold-DbContext 

"Server=SERVER_NAME;Database=DATABASE_NAME;Trusted_Connecti
on=True;" Microsoft.EntityFrameworkCore.SqlServer -OutputDir Models 

 
รูปที ่4.30 แสดงค าสั่งติดตั้ง EF Database ผา่น Nuget Package Console 

ภายใน model จะถูกสร้างข้ึนภายใน model folder  

 
รูปที ่4.31 แสดง model ท่ีถูกสร้างข้ึนจากการ  Mapping กบั Database 

ภายในไฟล ์EmployeeContext.cs Function OnConfiguring() 
ตรง ConnectionString เพิ่ม User ID และ password 
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รูปที ่4.32 แสดงการเช่ือมต่อ ConnectionString ท่ี EmployeeContext.cs 
 

• In file Startup.cs  
• Function OnConfiguringServices()  
• Insert connection string 

 

 
 

รูปที ่4.33 แสดงการเช่ือมต่อ ConnectionString ท่ี startup.cs 
 

สร้างหนา้ Controller 
• Go to Controllers => Add => Controller 
• Select MVC Controller with views, using Entity Framework 
• Copy code from old project and custom fix 
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รูปที ่4.34 แสดงการสร้างไฟล ์Controller.cs ดว้ย MVC using EF 
 

หรือจะ copy file ทั้งหมดจาก controller โปรเจคเก่า 
• Or Copy files all Controllers from old project to new Controller folder project  
• PS in this case have a one file 
• Fix and using reference 

 
รูปที ่4.35 แสดงไฟลแ์ละท่ีอยู ่Controller.cs 
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•  เร่ิมตน้ใช ้DB Context ใน Controller 
• Entity Database set using Constructor sender parameter values db 
• Declare variable type DBContext and set value from constructor for reference Database 

 
รูปที ่4.36 แสดงการประกาศเรียกใช ้EF จาก Controller 

 
• หนา้ Index 

• ActionResult is changed in .asp.net Core use IActionResult but available ActionResult 
witch ActionResult is implement from IActionResult  

• In this case using JSON for Return Data to Index page 
 

 
รูปที ่4.37 แสดงการ Return Value ในแบบ IActionResult 
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• หนา้ Detail 
• {HTTP GET}  

• Get value from parameter int?id 
• Search using Find Function by sender id get data to show  

 

 
 

รูปที ่4.38 แสดงการ Return Value หนา้ Detail HTTP GET 
 

• หนา้ Create 
• {HTTP GET}  

• Using ViewData for set value to SelectList 
• {HTTP POST} 

• Using EF db add new Data and Save using SaveChangeAsync() 

 
 

รูปที ่4.39 แสดงการ Return Value หนา้ Create HTTP GET,POST 
• หนา้ Delete 
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• {HTTP GET}  
• Get value from parameter int?id 
• Search using Find Function by sender id get data to show  

• {HTTP POST} 
• Get id is primary key from parameter for delete into database. 

 

 
 

รูปที ่4.40 แสดงการ Return Value หนา้ Delete HTTP GET,POST 
 

• Create new View Page 
• Views=>Right click => Add=>Folder 
• Right Click new Folder =>add View 
• Copy all View Page.cshtml from old project and custom is match model all page 
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รูปที ่4.41 แสดงเก็บไฟลห์นา้ View cshtml 

• Change @model to 
• @model [Namespace].Models.[ModelName]  
• All Razor Page is relate Data Entity 

• Index.cshtml 
• Detail.cshtml 
• Create.cshtml 
• Update.cs.html 
• Delete.cs.html 

 
รูปที ่4.42 แสดงตวัอยา่งหนา้ ViewPage 
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• In wwwroot contain 
• CSS (contain file css style for style web) 
• Image(contain images,icons ,etc) 
• Js(contain JavaScript files) 
• Lib(others library ,bootstap,datatables,etc..) 
•  

 
 

รูปที ่4.43 แสดงโครงสร้างภายใน wwwroot 
 

• Add Bootstrap 
• In lib folder right click new folder 
• Create name bootstrap 
• Copy files bootstrap into folder. 
• In css folder copy files bootstrap into folder 
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รูปที ่4.44 แสดงโครงสร้างท่ีอยูไ่ฟล ์bootstrap 
 

• Go to View=>Shared File _Layout.cshtml 
• Add CSS reference 

• <link ref=“stylesheet” href="~/css/bootstrap-file.css”> 

 
 

รูปที ่4.45 แสดงตวัอยา่งการอา้ง link CSS 
 
 

• Goto View=>Shared File _Layout.cshtml 
• Add JS reference 

• <script src=“~/lib/bootstrap/dist/js/bootstrap.js”></script> 
 



60 
 

 
รูปที ่4.46 แสดงตวัอยา่งการอา้ง link JavaSctipt 

 
• Add jQuery 

• In lib folder right click new folder 
• Create name jquery, jquery-validation,jquery-validation-unobtrusive 
• Copy files jquery into folder. 

 
 

รูปที ่4.47 แสดงโครงสร้างส าหรับเก็บ jQuery 
 
 

• Goto View=>Shared File _Layout.cshtml 
• Add reference 
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รูปที ่4.48 แสดงการเรียกใช ้link jQuery 
 

• Add DataTables plugin for JQuery 

 
รูปที ่4.49 แสดงตวัอยา่ง DataTable ส าหรับแสดงขอ้มูล 
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• In lib folder right click new folder 
• Create name DataTables 
• Copy files DataTables into folder. 
• In css folder copy files DataTables into folder 

 

 
รูปที ่4.50 แสดงท่ีอยูข่อง lib DataTables #1 

 
• In lib folder right click new folder 
• Create name DataTables  
• Copy files DataTables into folder. 
• In css folder right click new folder 
• Create name DataTables 
• Create name sprinner 
• Copy file image gif into folder 
• copy files DataTables into folder 
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รูปที ่4.51 แสดงท่ีอยูข่อง lib DataTable #2 

 
• Go to View=>Shared File _Layout.cshtml 

• Add CSS reference 
• <link ref=“stylesheet” 

href="~/css/DataTable/css/jquery.dataTables.css”> 
•  

 
 

รูปที ่4.52 แสดงตวัอยา่งการเรียกใช ้link DataTables ในส่วน CSS 
 

• Goto View=>Shared File _Layout.cshtml 
• Add JS reference 

• <script src=“~/lib/DataTables/jquery.dataTable.js”></script> 
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รูปที ่4.53 แสดงตวัอยา่งการเรียกใช ้link DataTables ในส่วน JavaScript 
 

• Goto View=>Index.cshtml 
• Add Json Render 

 

 
 

รูปที ่4.54 แสดงตวัอยา่งการใชง้านกบัหนา้ View ในการ render ผา่น ID 
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รูปที ่4.55 แสดงตวัอยา่งการใชง้านกบัหนา้ View ในการ render ส่งผา่นโดย JSON 
 

• Go to Controller 
• Add {http} return Json data 
• In function Index return view() 

 
 

รูปที ่4.56 แสดงตวัอยา่งการใชง้านกบัหนา้ View ในการ render ส่งผา่นโดย JSON ใน Controller 
 

• click run  
• When go to  

• Data return in type json format 
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รูปที ่4.57 แสดงตวัอยา่งการยงิขอ้มูล  JSON เพื่อดูการ return 

 

 
รูปที ่4.58 แสดงหนา้สมบูรณ์หลงัจากใช่งานร่วมกบั DataTables 

 
4.1.4.2 Migrate ASP.Net to ASP.NET Core ตัว E-Custom Web Application ของลูกค้า 

ในการทดสอบการ Migrate ASP.Net to ASP.NET Core โปรเจคลูกคา้ นั้นไดท้  าการทดสอบเพียง
แค่ 2 modules ในการโยกยา้ย ซ่ึงขนาดโครงสร้างโปรเจคท่ีเกร่ินไปในบทท่ี 3 แลว้นั้น มีขนาดท่ีใหญ่และ
ตอ้งใชเ้วลานานในการพฒันาทั้งหมดใหมี้ความเสถียรและสมบูรณ์แบบจึงไดย้กมาเพื่อเป็นตวัน าเสนอให้
ทางบริษทั A-HOST พิจารณาขั้นตอนในการ migrate วา่คุม้ค่าท่ีจะท าหรือไม่? 
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4.1.4.2.1 Initialize Asp.net core 
4.1.4.2.1.1 First start  

 new project asp.net core 2.1 
 Select ASP.NET Core Web Application 
 Project name MVC_xxxxx_NETCore 
 Next step click OK 

 

 
 

รูปที ่4.59 แสดงการสร้าง new project 
 

 Select ASP.NET Core 2.1 
 Select Web Application (MVC) 
 Next step click OK 
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รูปที ่4.60 แสดงการสร้าง new project แบบ MVC 
 

 เม่ือ create new project เสร็จจะแสดงหนา้แรก First Page 
 สามารถทดสอบโดยการ Run project 

 

 
 

รูปที ่4.61 แสดงหนา้การทดสอบโดยการ run ผา่น IIS Express 
 เม่ือรันจะเร่ิมตน้ start browser ซ่ึงจะแสดงหนา้ WebApp ข้ึนมา  
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 จากนั้นกด Accept 

 
รูปที ่4.62 แสดงปุ่มกด Accept บน Browser Chrome  

 

 
รูปที ่4.63 แสดงหนา้การทดสอบบน Browser Chrome ผา่น IIS Express 

4.1.4.2.1.2 Connect Database Existing 
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 ไปท่ี NuGet Package Manager Console follow this command 
 Install-Package Microsoft.EntityFrameworkCore.SqlServer 
 Install-Package Microsoft.EntityFrameworkCore.Tools 
 Install-Package Microsoft.VisualStudio.Web.CodeGeneration.Design 

 ท าการ mapping database using command 
 Scaffold-DbContext 

"Server=SERVER_NAME;Database=EZYMNANN;Trusted_Connection=True;
" Microsoft.EntityFrameworkCore.SqlServer -OutputDir Models 

 

 
 

รูปที ่4.64 แสดงการใช ้command บน Package Mananger Console 
 

 จากนั้น ภายใน folder Model จะเพิ่ม class ตาม Database ท่ีมี 
 

 
 

รูปที ่4.65 แสดงโครงสร้าง path ของ models 
• Initialize set Database Entity Model 
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 จากนั้นท าการ ใส่ ConnectionString ใน Model\xxxxxContext.cs 

 
 

รูปที ่4.66 แสดงการเช่ือมต่อ connection String ท่ี ModelContext 
 

 และ Startup.cs 

 
รูปที ่4.67 แสดงการเช่ือมต่อ connection String ท่ี Statup.cs 

 
4.4.2.1.3 Initialize Layout & Link Style ,Libs 

 Copy folder Content ,lib , Scripts ภายใน project เก่าทั้งหมด มาไวท่ี้ wwwroot 

 
รูปที ่4.68 แสดงการยา้ยจาก content project เก่าไป content project ใหม่ 

 บางอยา่งหากยงัไม่มีใหท้  าการ comment ไวก่้อน 
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รูปที ่4.69 แสดงการยา้ยจาก scripts project เก่าไป scripts project ใหม่ 
 

 จากนั้นมาเรียกใชท่ี้ Shared\_Layout.cshtml เน่ืองจากภายใน project ไม่มีการเรียกใชใ้น
แบบ bundle config 
 

 
 

รูปที ่4.70 แสดงการยา้ยจาก BundleConfig ไป Layout 
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 หลงัจาก copy เสร็จแลว้จะเห็นไดว้า่ ตวั @Scripts.Render, @Styles.Render ทั้งหมดไม่
สามารถใชง้านไดเ้น่ืองจากไม่มี bundle Config โดยตอ้งท าการเรียกตรง ๆ เช่น 

  @Styles.Render("~/Content/css") จะไดเ้ป็นทั้งหมดท่ีอยูใ่น /Content/css 
 <link href="~/Content/DataTables/css/dataTables.bootstrap.css" rel="stylesheet" 

/> 
 <link href="~/Content/DataTables/css/ezymanStyle.css" rel="stylesheet" /> 
  

 
 

รูปที ่4.71 แสดงการเรียกใชจ้าก @Render ไปเป็นเรียกใช ้ตรงๆ link 
 

4.4.2.1.4 Controller 
 สร้าง BaseController จากนั้นท าการ copy โคด้ท่ีจ  าเป็นตอ้งใชม้าบางส่วน ส าหรับ function 

ท่ีจ  าเป็นตอ้งมีในส่วนของ module Manifest Schedule , Vessel Schedule ไดแ้ก่  
 Methods 

 increaseDocRunning  
 Logging 
 GetValidateDataList 
 GlobalNotify 
 GlobalSwal 
 HistoryList 
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 CancelList 
 GetEbXMLFileName 
 WriteCancelXML 

 

 
 

รูปที ่4.72 แสดงตวัอยา่ง Class Base Controller 
 

 increaseDocRunning 

 
รูปที ่4.73 แสดงตวัอยา่ง Function IncreaseDocRunning 

 
 Logging 

 

 
รูปที ่4.74 แสดงตวัอยา่ง Function Logging 
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 GetValidateDataList 
 

 
 

รูปที ่4.75 แสดงตวัอยา่ง Function GetValidateDataList 
 

 GlobalNotify 

 
 

รูปที ่4.76 แสดงตวัอยา่ง Function GlobalNotify 
 

 GlobalSwal 
 

 
 

รูปที ่4.77 แสดงตวัอยา่ง Function GlobalSwal 
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 HistoryList 
 

 
 

รูปที ่4.78 แสดงตวัอยา่ง Function HistoryList 
 

 CancelList 
 

 
 

รูปที ่4.79 แสดงตวัอยา่ง Function CancelList 
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 GetEbXMLFileName 
 

 
รูปที ่4.80 แสดงตวัอยา่ง Function GetEbXMLFileName 

 
 WriteCancelXML มีบาง class ไม่สามารถใชง้านไดท้  าใหต้อ้งใชอ้ยา่งอ่ืน

ทดแทนไดแ้ก่ Section ,Response, rootparth ซ่ึงจะถูกส่งฝ่ังขา Controller ผา่น 
parameters 
 

 
รูปที ่4.81 แสดงตวัอยา่ง Function WriteCancelXML 

 
 Variables 

 conString 
 Environment 
 Db 
 userID 
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รูปที ่4.82 แสดงตวัอยา่ง Variebles ของ BaseController.cs 
 

• Model 
 ไปท่ี Models\DocRunning.cs ท าการแกไ้ขช่ือตวัแปรใหเ้หมือนตน้ฉบบั 

 

 
 

รูปที ่4.83 แสดงตวัอยา่งการเปล่ียน ตวัแปร ภายใน model 
 

 จะเห็นไดว้า่มีบางตวัแปรภายใน model ท่ีไม่มี ซ่ึงจะถูกสร้างข้ึนมาเพื่อใชใ้นการส่งค่า
เท่านั้น โดยเราไม่สามารถใชว้ธีิเดิมไดด้งันั้นจึงจ าเป็นตอ้งสร้าง custom class ข้ึนมาเพื่อใช้
แทนในการส่งค่า โดย เร่ิมแรก 

 ท าการสร้าง folder custom ภายใน Models จากนั้นสร้าง class ช่ือเดิมเพื่อเป็นการ
ไม่สับสน 

 ท าการ extends class model เดิม 
 ท าการเพิ่ม ตวัแปร ท่ีนอกเหนือจาก database ท่ี EF  generate มา 
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รูปที ่4.84 แสดงตวัอยา่งการ custom model 
 

• Utilities 
 ท าการสร้าง folder ใหม่ช่ือ Utilities ภายใต ้MVC_xxxxx_NETCore 
 ท าการ สร้าง 3  class ไดแ้ก่ 

 xxxxxUserAccount.cs 
 xxxxxUserAccountServices.cs 
 UserAccount.cs 

 จากนั้นท าการ copy ทั้ง 3 class จากตน้ฉบบั 

 
รูปที ่4.85 แสดงตวัอยา่งการสร้าง Utilities UserAccount 
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 ส าหรับตวัอยา่งน้ีจะท าการแกไ้ขไฟล ์xxxxUserAccountServices.cs 
  โดย ก าหนดค่า user เป็นสิทธ์ิ Admin เพราะไดท้ดลองท าเพียงแค่ 2 module ซ่ึง

ไม่ไดใ้ส่ในส่วนของ section 
 

 
รูปที ่4.86 แสดงตวัอยา่งการก าหนดค่า UserAccount 

 
4.1.4.2.2 Manifest Schedule 
4.1.4.2.2.1 Prepare Model 

 ไปท่ี Models\ManifestSchedule.cs จะเห็นวา่ช่ือตวัแปรท่ีถูกสร้างข้ึนนั้นไม่เหมือนกบั
ตน้ฉบบั 
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รูปที ่4.87 แสดงตวัอยา่งไฟล ์model 

 
 ตอ้งท าการเปล่ียนพร้อมกบัใส่ annotation ให้เหมือนตน้ฉบบั 

 
 

รูปที ่4.88 แสดงตวัอยา่งการเปล่ียนตวัแปร 
 

 จากนั้นตอ้งไปท าการแกไ้ขท่ี  xxxxxContext.cs ท าการแกไ้ขในส่วน modelBuilder ทุก ๆ 
entity ใหเ้หมือนกบัใน models ManifestSchedule.cs 

 



82 
 

 
 

รูปที ่4.89 แสดงตวัอยา่งการเปล่ียนตวัแปรหนา้ ModelContext 
 

 จะเห็นไดว้า่มีบางตวัแปรภายใน model ท่ีไม่มี ซ่ึงจะถูกสร้างข้ึนมาเพื่อใชใ้นการส่งค่า
เท่านั้น โดยเราไม่สามารถใชว้ธีิเดิมไดด้งันั้นจึงจ าเป็นตอ้งสร้าง custom class ข้ึนมาเพื่อใช้
แทนในการส่งค่า โดย เร่ิมแรก 

 ท าการสร้าง folder custom ภายใน Models จากนั้นสร้าง class ช่ือเดิมเพื่อเป็นการ
ไม่สับสน 

 ท าการ extends class model เดิม 
 ท าการเพิ่ม ตวัแปร ท่ีนอกเหนือจาก database ท่ี EF  generate มา 
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รูปที ่4.90 แสดงตวัอยา่งการ custom model 
 

 ท าการสร้าง Controller ไปท่ี folder Controllers จากนั้น คล้ิกขวา Add => Controller…  
 เลือก MVC Controller with view, using Entity Framework จากนั้นกด Add 
 ช่ือ Manifest_Schedule ให้เหมือนกบัตน้แบบ 

 

 
 

รูปที ่4.91 แสดงการสร้าง class controller ใหม่ 
 

 
 สร้าง Constructor รับค่า Parameters EF database และ Environment ให ้Super Class โดย 

extends มาจาก BaseController.cs 



84 
 

 
 

รูปที ่4.92 แสดงตวัอยา่ง class Manifest_SchduleController 
 

4.1.4.2.2.2 Index : View 
 จากการสร้าง controller ท าใหห้นา้ View ถูก Generate 
 ไปท่ี View\Manifest_Schedule\Index.cshtml 
 ท าการลบ code เก่าออกแลว้ copy code มาจากตน้แบบ 

 

 
 

รูปที ่4.93 แสดงตวัอยา่ง Index.cshtml 
 
 

 ระวงัในส่วน Ajax โดยมีการ Return Json() โดยแกไ้ข Field ใหต้รงกบัค่าท่ีส่งมา 
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รูปที ่4.94 แสดงตวัอยา่ง Index.cshtml ในส่วน Script AJAX 

 
4.1.4.2.2.3 Index :Controller 

 ไปท่ี Controllers\ Manifest_ScheduleController.cs 
 ท าการลบ code เก่าออกแลว้  แลว้เพิ่ม 2 function ลงไป (ค าเตือน ! ใส่ส่วนท่ียงัไม่ไดยุ้ง่ ให้

ปล่อยไว ้หรือ comment ไวก่้อน) 
 

 
รูปที ่4.95 แสดงตวัอยา่ง function ในส่วน Index หนา้ Controller  
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รูปที ่4.96 แสดงตวัอยา่งManifestSchdule หนา้ Index  

 
4.1.4.2.2.4 Create : View 

 ไปท่ี View\Manifest_Schedule\Create.cshtml 
 ท าการลบ code เก่าออกแลว้ copy code มาจากตน้แบบและเปล่ียน model 

 
 

รูปที ่4.97 แสดงตวัอยา่ง create.cshtml 
 ไปท่ี View\Manifest_Schedule\ สร้าง Razor Page Modal.cshtml 
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 copy code มาจากตน้แบบ 

 
 

รูปที ่4.98 แสดงตวัอยา่ง Modal.cshtml 
 

 ท่ี View\Manifest_Schedule\Create.cshtml 
 มีการอา้ง Partial เพื่อเรียกใช ้Model.cshtml 

 

 
 

รูปที ่4.99 แสดงตวัอยา่ง Create.cshtml อา้งถึง Modal.cshtml 
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รูปที ่4.100 แสดงตวัอยา่งหนา้ Create  เม่ือกดปุ่มคน้หา Modal จะแสดงข้ึนมา 

 
4.1.4.2.2.5 Create :Controller 

 ไปท่ี Controllers\ Manifest_ScheduleController.cs 
 ท าการลบ code เก่าออกแลว้  แลว้เพิ่ม 2 function ลงไป (ค าเตือน ! ใส่ส่วนท่ียงัไม่ไดยุ้ง่ ให้

ปล่อยไว ้หรือ comment ไวก่้อน) 
 

 
 

รูปที ่4.101 แสดงตวัอยา่ง Function Create :post 
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รูปที ่4.102 แสดงตวัอยา่ง Function Create ท่ีเก่ียวขอ้ง 

 
 4.1.4.2.2.6 Edit : View 

 ไปท่ี View\Manifest_Schedule\Edit.cshtml 
 ท าการลบ code เก่าออกแลว้ copy code มาจากตน้แบบ 
 แกไ้ขในส่วน  model 

 
 

รูปที ่4.103 แสดงตวัอยา่ง Edit.cshtml 
 

 ท่ี View\Manifest_Schedule\Edit.cshtml มีการอา้ง Partial เพื่อเรียกใช ้Model.cshtml 
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รูปที ่4.104 แสดงตวัอยา่งการอา้งถึงไฟล ์modal.cshtml ดว้ยการใช ้partial view 
 

 ท่ี View\Manifest_Schedule\Edit.cshtml ส่วน js ขา้งล่างมีการรับค่าโดยใช ้Ajax อยู ่4 
function  

 
รูปที ่4.105 แสดงตวัอยา่งการรับส่งขอ้มูลในรูป api ดว้ย ajax 

 
4.1.4.2.2.7 Edit :Controller 

 ไปท่ี Controllers\ Manifest_ScheduleController.cs 
 ท าการลบ code เก่าออกแลว้  แลว้เพิ่ม 3 function ลงไป (ค าเตือน ! ใส่ส่วนท่ียงัไม่ไดยุ้ง่ ให้

ปล่อยไว ้หรือ comment ไวก่้อน) 
 Edit ฝ่ัง GET 
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รูปที ่4.106 แสดงตวัอยา่ง function edit ฝ่ัง Get 
 

 Edit ฝ่ัง GET ตอ้งส่งค่าไปแสดงท่ี View จึงตอ้งท าการ set ขอ้มูลก่อนถูกจะส่งได ้
เน่ืองจาก model นั้นไม่ตรงกนัซ่ึงมีการ custom 

 
 

รูปที ่4.107 แสดงตวัอยา่ง model ท่ีถูก Custom 
 

 Edit ฝ่ัง POST เปล่ียนไปใช ้custom model 
 การแปลงค่า จาก String to Integer ไม่สามารถใช ้AsInt() ใหเ้ปล่ียนมาใช ้

int.Parse() แทนทั้งหมด 
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รูปที ่4.108 แสดงตวัอยา่งการ bind ค่า custom model กบั การแปลงค่าจาก string to int 
 

 
 

รูปที ่4.109 แสดงผลลพัธ์หนา้ Edit ของ Manifest Schedule 
 CopyManifest ท าการ copy ตน้แบบปรับเปล่ียนตรงวธีิดึง path file 
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 Path file นั้นใชว้ธีิ fix ค่าโดยค่าอยูท่ี่ BaseController.cs ซ่ึงเป็น Super Class ซ่ึง
ปกติแลว้ตอ้งดึงค่ามาจาก appsetting.json ถึงจะเป็นวธีิท่ีดีท่ีสุด 
 

 
รูปที ่4.110 แสดงตวัอยา่ง function copy เม่ือท าการกดปุ่ม copy Manifest 

 

 
 

รูปที ่4.111 แสดงผลลพัธ์เม่ือท าการ copy Ref.  
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4.1.4.2.3 Vessel Schedule 
4.1.4.2.3.1 Prepare Model 

 ไปท่ี Models\Vsed.cs จะเห็นวา่ช่ือตวัแปรท่ีถูกสร้างข้ึนนั้นไม่เหมือนกบัตน้ฉบบั 

 
รูปที ่4.112 แสดงตวัอยา่ง model class vesd 

 ตอ้งท าการเปล่ียนพร้อมกบัใส่ annotation ให้เหมือนตน้ฉบบั 
 

 
รูปที ่4.113 แสดงตวัอยา่งการปรับเปล่ียนตวัแปร class Model Vsed 

  จะเห็นไดว้า่มีบางตวัแปรภายใน model ท่ีไม่มี ซ่ึงจะถูกสร้างข้ึนมาเพื่อใชใ้นการส่งค่า
เท่านั้น โดยเราไม่สามารถใชว้ธีิเดิมไดด้งันั้นจึงจ าเป็นตอ้งสร้าง custom class ข้ึนมาเพื่อใช้
แทนในการส่งค่า โดย เร่ิมแรก 

 สร้าง class ช่ือ Vsed.cs พร้อมก าหนดค่าใน constructor 
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 ท าการ extends class model เดิม 
 ท าการเพิ่ม ตวัแปร ท่ีนอกเหนือจาก database ท่ี EF  generate มา 

 

 
 

รูปที ่4.114 แสดงตวัอยา่งการ custom model Vsed 
 

 จากนั้นตอ้งไปท าการแกไ้ขท่ี  xxxxxContext.cs ท าการแกไ้ขในส่วน modelBuilder ทุก ๆ 
entity ใหเ้หมือนกบัใน models\Vsed.cs 
 

 
รูปที ่4.115 แสดงตวัอยา่งการปรับเปล่ียนตวัแปรท่ี Context Model 
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4.1.4.2.3.2 Prepare Controller 

 ท าการสร้าง Controller ไปท่ี folder Controllers จากนั้น คล้ิกขวา Add => Controller…  
 เลือก MVC Controller with view, using Entity Framework จากนั้นกด Add 
 ช่ือ VSEDs ใหเ้หมือนกบัตน้แบบ 
 

 
 

รูปที ่4.116 แสดงตวัอยา่งการปรับเปล่ียนตวัแปรท่ี Context Model 
 สร้าง Constructor รับค่า Parameters EF database และ Environment ให ้Super Class โดย 

extends มาจาก BaseController.cs 

 
 

รูปที ่4.117 แสดงตวัอยา่ง VesdController 
 

4.1.4.2.3.3 Index : View 
 จากการสร้าง controller ท าใหห้นา้ View ถูก Generate 
 ไปท่ี Views\VSEDs\Index.cshtml 
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 ท าการลบ code เก่าออกแลว้ copy code มาจากตน้แบบ 
 

 
 

รูปที ่4.118 แสดงตวัอยา่ง Index.cshtml 
 

 ระวงัในส่วน Ajax โดยมีการ Return Json() โดยแกไ้ข Field ใหต้รงกบัค่าท่ีส่งมา 
 

 
 

รูปที ่4.119 แสดงตวัอยา่ง Index.cshtml ในส่วน ajax 
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4.1.4.2.3.4  Index :Controller 

 ไปท่ี Controllers\ VSEDsController.cs 
 ท าการลบ code เก่าออกแลว้  แลว้เพิ่ม 2 function ลงไป (ค าเตือน ! ใส่ส่วนท่ียงัไม่ไดยุ้ง่ ให้

ปล่อยไว ้หรือ comment ไวก่้อน) 

 
 

รูปที ่4.120 แสดงตวัอยา่ง function ในส่วน Index 
 

 
 

รูปที ่4.121 แสดงผลลพัธ์ของหนา้ Index module Vesel Schedule 
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4.1.4.2.3.5  Create : View 

 ไปท่ี View\VSEDs\Create.cshtml 
 ท าการลบ code เก่าออกแลว้ copy code มาจากตน้แบบและเปล่ียน model 

 
 

รูปที ่4.122 แสดงตวัอยา่ง view ของหนา้ create.cshtml 
 

 ไปท่ี Views\VSEDs\ สร้าง Razor Page Modal.cshtml 
 copy code มาจากตน้แบบ 

 
 

รูปที ่4.123 แสดงตวัอยา่ง view ในส่วน model.cshtml 
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 ไปท่ี Views\VSEDs\ สร้าง Razor Page ModalPopup.cshtml 
 copy code มาจากตน้แบบ 

 

 
 

รูปที ่4.124 แสดงตวัอยา่ง view ในส่วน ModalPopup.cshtml 
 

 ท่ี Views\VSEDs\Create.cshtml 
 มีการอา้ง Partial เพื่อเรียกใช ้Model.cshtml  ,ModelPopup.cshtml 

 

 
 

รูปที ่4.125 แสดงตวัอยา่งการเรียกใช ้Modal,ModalPopup ดว้ย Partial view 
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รูปที ่4.126 แสดงตวัอยา่งผลลพัธ์ Modal,ModalPopup ดว้ย Partial view 

 
4.1.4.2.3.6 Create :Controller 

 ไปท่ี Controllers\ VSEDsController.cs 
 ท าการลบ code เก่าออกแลว้  แลว้เพิ่ม 7 function ลงไป (ค าเตือน ! ใส่ส่วนท่ียงัไม่ไดยุ้ง่ ให้

ปล่อยไว ้หรือ comment ไวก่้อน) 
 Create :  GET 

 เนน้ส่งค่าโดยผา่น ViewBag เป็นส่วนใหญ่ 
 จดัการกบั format date time 
 Return view() 

 
รูปที ่4.127 แสดงตวัอยา่ง function create ฝ่ัง Get 
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 OnCheckDate :  POST 
 ท าการ check date ส่งค่า return json format  
 ท่ีหนา้ modal.cshtml 

 

 
 

รูปที ่4.128 แสดงตวัอยา่ง function OnCheckDate ท่ี  Modal.cshtml 
 

 OnSearchSelect :  POST 
 

 
 

รูปที ่4.129 แสดงตวัอยา่ง function OnSearchSelect 
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 Action :  POST 
 

 
 

รูปที ่4.130 แสดงตวัอยา่ง function Action 
 

 OnSearch :  POST 
 

 
 

รูปที ่4.131 แสดงตวัอยา่ง function OnSearch 
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 CheckValidation :  POST 

 
 

รูปที ่4.132 แสดงตวัอยา่ง function CheckValidation 
 

 Create :  POST 
 มีการแกไ้ขในส่วน model ท าใหต้อ้งก าหนดค่าก่อนท าการ save 

 

 
 

รูปที ่4.133 แสดงตวัอยา่ง function Create 
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รูปที ่4.134 แสดงผลลพัธ์หนา้ create ของ Vessel Schedule 
 
 
 
4.1.4.2.3.7 Edit : View 

 ไปท่ี View\VSEDs\Edit.cshtml 
 ท าการลบ code เก่าออกแลว้ copy code มาจากตน้แบบและเปล่ียน model 
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รูปที ่4.135 แสดงตวัอยา่งไฟล ์edit.cshtml 
 

 ไปท่ี Views\ สร้าง Razor Page CancelModel.cshtml 
 copy code มาจากตน้แบบ 

 
 

รูปที ่4.136 แสดงตวัอยา่งไฟล ์CancelModal.cshtml 
 

 ไปท่ี Views\ สร้าง Razor Page HistoryModel.cshtml 
 copy code มาจากตน้แบบ 
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รูปที ่4.137 แสดงตวัอยา่งไฟล ์HistoryModal.cshtml 
 

4.1.4.2.3.8 Edit :Controller 
 ไปท่ี Controllers\ VSEDsController.cs 
 ท าการลบ code เก่าออกแลว้  แลว้เพิ่ม 8 function ลงไป (ค าเตือน ! ใส่ส่วนท่ียงัไม่ไดยุ้ง่ ให้

ปล่อยไว ้หรือ comment ไวก่้อน) 
 Edit :  GET 

 

 
 

รูปที ่4.138 แสดงตวัอยา่ง function edit ขา Get 
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 Edit :  GET 
 มีการปรับเปล่ียน โดยใช ้custom model ในการส่งค่าไปแสดงหนา้ view 

 

 
 

รูปที ่4.139 แสดงตวัอยา่ง การแทนค่า จาก Model 
 

 Edit :  POST 
 มีการปรับเปล่ียน โดยใช ้custom model ในการรับค่าจากหนา้ view  โดยการ 

binding 
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รูปที ่4.140 แสดงตวัอยา่ง การรับค่าโดยการBinding CustomModel 
 

 Edit :  POST 
 มีการปรับเปล่ียน การแปลง ขอ้มูลจาก String to Integer จาก asInt => int.Parse 

 

 
 

รูปที ่4.141 แสดงตวัอยา่ง การแปลงค่า จาก string to integer 
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รูปที ่4.142 แสดงผลลพัธ์หนา้ edit คร่ึงบน 
 

 
 

รูปที ่4.143 แสดงผลลพัธ์หนา้ edit คร่ึงล่าง 
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 CopyVSED :  POST 
 ปรับเปล่ียนโดยรับค่า connection string จาก BaseController 

 

 
 

รูปที ่4.144 แสดงตวัอยา่ง function CopyVSED 
 

 
 

รูปที ่4.145 แสดงผลลพัธ์หนา้ edit เม่ือกด Copy 
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 Exports :  POST 
 Export file โดยน าขอ้มูลออกอยูใ่นรูป xml format 

 

 
 

รูปที ่4.146 แสดงตวัอยา่ง function Exports 
 

 ท าการใช ้class XmlSerializer โดยใช ้CustomVesselSchdule.cs เป็น Model ใน
การสร้าง xml 

 มีการปรับเปล่ียนการ download file  โดยใช ้class FileStreamResult 
 

 
 

รูปที ่4.147 แสดงตวัอยา่ง function Exports ในการใช ้model gen xml 
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 ท าการสร้าง file CustomsVesselSchedule.cs ภายใต ้Controller/ 
 จากนั้น copy จากตน้แบบทั้งหมด 

 
 

รูปที ่4.148 แสดงตวัอยา่งไฟล ์CustomsVesselSchedule.cs 
 

 CancelVSED :  POST 
 Copy จากตน้ฉบบั จากนั้นท าการสร้างไฟล ์CustomsCancelManifests.cs เพื่อเป็น 

model ในการ export xml 
 

 
รูปที ่4.149 แสดงตวัอยา่ง function CancelVSED 
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 Copy จากตน้ฉบบั ไปวางไวท่ี้  CustomsCancelManifests.cs  
 cancelDocument :  POST 

 
รูปที ่4.150 แสดงตวัอยา่ง function cancelDocument 

 
 VsedExists  

 
รูปที ่4.151 แสดงตวัอยา่ง function VsedExists 

 
 SaveDuplicateCancle 

 
 

รูปที ่4.152 แสดงตวัอยา่ง function SaveDuplicateCancel 
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รูปที ่4.153 แสดงผลลพัธ์เม่ือท าการกดปุ่ม export xml 
 

 
 

รูปที ่4.154 แสดงผลลพัธ์การดาวโหลด xml file ลง ระบบ 



116 
 
4.1.5 Tester 

- ช่วยทดสอบระบบ E-Custom Web Application ในส่วนต่าง ๆ คร่าวๆจากน้ันแจ้งให้กับ team  
- ช่วยทดสอบระบบ E-SYNC (Service) โดยหา error ในระหว่างการท างาน 

 

 
 

รูปที ่4.155 แสดงผลลพัธ์การท างานของตวัโปรแกรม 
 

4.2 ผลการวเิคราะห์ข้อมูล 
4.2.1 ระบบ E-CUSTOM WEB APPLICATION 

ตามท่ีไดด้ าเนินการโครงการพฒันาระบบ E-custom Web application ร่วมกบั ทีมภายในบริษทั A-Host 
Company limited. ของบริษทั T Services. (นามสมุติ) ไดด้ าเนินการเกือบส าเร็จลุล่วงแลว้ ในส่วนของ New 
Requirement, Fix Bug, Defect นั้นไดส้ าเร็จ สามารถใช้งานได้เป็นไปตามความตอ้งการของลูกคา้ และท า
การ push ฝ่ัง Server ลูกคา้เรียบร้อยแลว้ 

 
 

รูปที ่4.156 แสดงการใชง้านระบบหนา้แรก หนา้  login เขา้ใชง้าน 
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จากรูปท่ี 4.156 จะเห็นวา่เขา้ใชง้านระบบ จะตอ้งท าการระบุตวัตน Authunication เพื่อเขา้ใชง้านซ่ึง

ตรงจุดน้ีจะท าให้การเขา้ใช้งานแต่ละ Account นั้นจะมีสิทธ์ิท่ีจะเขา้ถูก modules หรือ function ต่างๆนั้นไม่
เท่ากนั โดยสิทธ์ิท่ีสูงท่ีสุดจะอยูท่ี่ Admin 
 

 
รูปที ่4.157 แสดงการใชง้านระบบ หนา้แรก 

 

 
รูปที ่4.158 แสดงการใชง้านระบบ Container list หนา้แรก 
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4.2.1 Research การ Migrate ASP.NET ไปเป็น ASP.NET Core 
4.2.1.1 Migrate ASP.NET to ASP.NET Core ตัวทดสอบ 
จากการ Migrate สามารถท าการโยกยา้ย ไดส้มบูรณ์ 99% ซ่ึงมีความพึ่งพอใจและสามารถน ามาใชจ้ริงได ้
 
หน้า Index 

 
 

รูปที ่4.159 แสดงการMigrate หนา้ Index 
หน้า Create 

 
 

รูปที ่4.160 แสดงการMigrate หนา้ Create 
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หน้า Edit 

 
 

รูปที ่4.161 แสดงการMigrate หนา้ edit 
หน้า Detail 

 

 
รูปที ่4.162 แสดงการMigrate หนา้ Detail 

 



120 
 
หน้า Delete 

 
รูปที ่4.163 แสดงการMigrate หนา้ Delete 

 
4.2.1.2 ทดสอบ Migrate ASP.NET to ASP.NET Core  (Web Application ลูกค้า) 

 
 

รูปที ่4.164 แสดงการ Migrate หนา้ Manifest Index 
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รูปที ่4.165 แสดงการMigrate หนา้ Manifest Add 
 

 
 

รูปที ่4.166 แสดงการMigrate หนา้ Manifest Edit 
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รูปที ่4.167 แสดงการMigrate หนา้ Vessel Schedule Index 
 

 
 

รูปที ่4.168 แสดงการMigrate หนา้ Vessel Schedule Create 
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รูปที ่4.169 แสดงการMigrate หนา้ Vessel Schedule Edit 
 

4.3 วิเคราะห์และวิจารณ์ข้อมูลโดยเปรียบเทียบผลที่ได้รับกับวัตถุประสงค์และจุดมุ่งหมายใน
การปฏบิัติงานหรือการจัดท าโครงงาน 

 
เม่ือท าการวิเคราะห์และเปรียบเทียบผลท่ีไดรั้บกบัวตัถุประสงคใ์นการปฏิบติังานแลว้ จะเห็นไดว้า่การ

น าเอาความรู้ท่ีไดรั้บการอบรมและเรียนรู้มา สามารถน ามาใชไ้ดใ้นการท างานจริง ซ่ึงแต่ความรู้ท่ีเรียนมานั้น
เป็นเพียงแค่แนวทางในการศึกษาต่อและการท างานเท่านั้ น ไม่สามารถศึกษาทั้งหมดได้ทั้ งน้ีข้ึนอยู่กับ
ประสบการณ์ในการปฏิบติังานจริง 

 
 ในการปฏิบติังานในส่วนท่ีไดรั้บมอบหมายไดป้ระสบความส าเร็จไปดว้ยดี ดว้ยความร่วมมือ ความ
ช่วยเหลือจากทีมทั้ง พี่ๆ ในบริษทั 
 

- การศึกษาท าความเข้าใจเก่ียวกับภาพรวมของระบบงานท่ีจะพัฒนา ท าให้เข้าใจกระบวนการ 

ขั้นตอนการท างาน ด าเนินการ เพื่อน ามาประยกุตใ์ชใ้นการพฒันาในโปรเจค 

- การศึกษาการใชง้านโปรแกรมท่ีจ าเป็นต่อการพฒันาระบบ ท าให้สามารถใชเ้คร่ืองมือในการพฒันา 
Software ได้อย่างคล่องแคล่ว รวดเร็ว สะดวก โปรแกรม ศึกษาหลกั ๆ Visual Studio, Microsoft 



124 
 

SQL Server Management Studio พร้อมด้วย การใช้ ภาษา Script SQL,C# .NET ,Lasor ,Lambda 
,Html.CSS, และการใช ้API อ่ืนๆ 

- ก ารพัฒ น า  Web Application E-CUSTOM WEB APPLICATION ใน ส่ วน ของงาน ท่ี ได้ รั บ
มอบหมาย ไดส้ าเร็จลุล่วงไปดว้ยดี รวมทั้งในส่วน fix bug และ defect 

- การศึกษาคน้ควา้ Research การ Migrate จาก ASP.NET ไปยงั ASP.NET Core  ในการ Migrate นั้น
สามารถโยกยา้ยจากตวัเก่าไปยงัตวัใหม่ไดป้ระสบความส าเร็จไปดว้ยดี แต่จากการศึกษาไม่สามารถ
ใชง้าน Source Code ตวัเก่าไดท้ั้งหมด คาดการไดว้า่ประมาณ 90% ซ่ึงเป็นท่ีน่าพึงพอใจ แต่ส าหรับ
การ migrate โปรเจค ท่ีมีขนาดเล็กและไม่ซบัซอ้น สามารถท าไดส้มบูรณ์ 100%  
 

    
 รูปที ่4.170 แสดงการ Migrate จาก ASP.NET to ASP.NET Core ตวัอยา่ง 

 

 
 

รูปที ่4.171 แสดงการ Migrate จาก ASP.NET to ASP.NET Core (ลูกคา้) 



  
 

บทที ่5 
บทสรุปและข้อเสนอแนะ 

 

5.1 สรุปผลการด าเนินงาน 
 

จากการด าเนินงานการพฒันาเวบ็แอพพลิเคชัน่เพื่อสนบัสนุนพิธีการศุลกากรอิเล็กทรอนิกส์ ของบริษทั 

T Services (นามสุมุติ) CO.LTD ท่ีไดรั้บมอบหมายให้ปฏิบติังานตามท่ีแผนก BS (Business Solution) ให้

พฒันาเขา้เวบ็แอพพลิเคชัน่ร่วมในโปรเจค E-Custom Web Application ซ่ึงร่วมพฒันากบัทีมของบริษทั A-
Host Company limited. โดยในส่วนท่ีไดรั้บมอบหมายหลกัๆจะถูกแบ่งออกแบบ 3 ส่วนดว้ยกนัดงัน้ี 

 
พฒันาในส่วนของตัว New Requirement ได้แก่  
- พฒันาในส่วน MMAN Dropdown list Add Berth No.การน าเขา้ขอ้มูลซ่ึงอยูใ่นรูปไฟล ์Text File 

(TXT) สู่ระบบดว้ยวธีิการ Upload 
- พฒันาในส่วนCLIS Import File 
- พฒันาในส่วน CLIS Export Excel (xls) 
- พฒันาในส่วน GridLine  Crystal Report 
- พฒันาในส่วน MMAN Warning Import Data Mismatch 
- พฒันาในส่วน MMAN Import : แจง้วา่มี BL No. ซ ้ าในไฟล ์Import 
- พฒันาในส่วน CLIS Import : แจง้วา่มี Container No. ซ ้ าในไฟล ์Import 
- พฒันาในส่วน MMAN Detail: เพิ่มฟิลดบ์อกจ านวนตูค้อนเทนเนอร์ 
- พฒันาในส่วน MMAN Detail : ปุ่มลดัไปเมนูสร้าง Master Customer 

 
การแก้ไขข้อผดิพลาดภายในระบบ (Fix Bug) 
- ขอ้มูลไม่บนัทึกลง Database เม่ือ Import text 
- Alert box ไม่แสดงขอ้ความ 
- Notify show Import file successfully 
- Notify show refresh successfully 
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- MMAN : กด cancel ขอ้มูล Detail ไม่ได ้
- MMAN : ลบขอ้มูลส่วน Detail ไม่ได ้
- MMAN : บนัทึกขอ้มูลส่วน header ไม่ได ้
- CLIS : Import file ขอ้มูล Ship Agent ไม่บนัทึก 
- CLIS : ฟิลด ์Con. Status ไม่แสดงขอ้มูลตามท่ี Import เขา้ไป (Import Text) 
- CLIS : ฟิลด ์CLD_CON_AGENT_NAME ไม่ถูกบนัทึก (Import Text) 
- CLIS : ฟิลด ์Container Operator และ Con. Status ไม่แสดงขอ้มูลตามท่ี Import เขา้ไป (Import 

XML) 
 

ปรับปรุงข้อบกพร่องระบบ 
- ปรับปรุงขอ้บกพร่องระบบ Area Code (Date Time) 
- ปรับปรุงขอ้บกพร่องระบบ CLIS Detail : ฟิลด ์Con. Status ไม่แสดงขอ้มูลตามท่ี Import เขา้ไป 
- ปรับปรุงขอ้บกพร่องระบบ CLIS Detail Information : ฟิลด ์Container Operator, Branch, หน่วยนบั 

ไม่แสดงขอ้มูลตามท่ี Import เขา้ไป) 
- ปรับปรุงขอ้บกพร่องระบบ CLIS Detail : เม่ือ Copy ขอ้มูล Detail ไม่ Copy Rack มาดว้ย 
- ปรับปรุงขอ้บกพร่องระบบ MMAN Copy Detail : เม่ือ Copy ขอ้มูล Detail ไม่ Copy Container มา

ดว้ย 
- ปรับปรุงขอ้บกพร่องระบบ MMAN Import : Import โดยไม่มี Container ได ้
-  

 
การศึกษาวธีิการโยกย้ายจากระบบเดิมไปสู่ระบบใหม่ Research ASP.NET to ASP.NET Core ไดแ้ก่ 
- ศึกษาการโยกยา้ยระบบ Migrate  ASP.NET to ASP.NET Core 
- จดัท า ตวัอยา่ง project demo ทดสอบการ migrate ประสบความส าเร็จ 100%  
- จดัท า ทดลอง โยกยา้ย migrate โปรเจคจริงของลูกคา้ จ  านวน 2 modules ซ่ึงประส าความส าเร็จ 95 

%  
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รูปที ่5.1  แสดงผลลพัธ์การทดสอบ Migration ในส่วน Manifest Schedule 
 

 

 
 

รูปที ่5.2 แสดงผลลพัธ์การทดสอบ Migration หนา้ Index ในส่วน Manifest Schedule 
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รูปที ่5.3 แสดงผลลพัธ์การทดสอบ Migration หนา้ Create(Add) ในส่วน Manifest Schedule 
 

 
 

รูปที ่5.4  แสดงผลลพัธ์การทดสอบ Migration หนา้ Create เม่ือมีการใช ้Function Select Port  
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รูปที ่5.5 แสดงผลลพัธ์การทดสอบ Migration หนา้ Edit ในส่วน Manifest Schedule 
 

 
 

รูปที ่5.6 แสดงผลลพัธ์การทดสอบ Migration หนา้ Edit เม่ือมีการใช ้Function Copy 
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รูปที ่5.7 แสดงผลลพัธ์การทดสอบ Migration ในส่วน Vessel Schedule 
 

 
 

รูปที ่5.8 แสดงผลลพัธ์การทดสอบ Migration หนา้ Index ในส่วน Vessel Schedule 
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รูปที ่5.9  แสดงผลลพัธ์การทดสอบ Migration หนา้ Create(Add) ในส่วน Vessel Schedule 
 

 
 

รูปที ่5.10 แสดงผลลพัธ์การทดสอบ Migration หนา้ Create เม่ือใช ้Function Select Manifest 
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รูปที ่5.11 แสดงผลลพัธ์การทดสอบ Migration หนา้ Edit ในส่วน Vessel Schedule 
 

 
 

รูปที ่5.12 แสดงผลลพัธ์การทดสอบ Migration หนา้ Edit ในส่วน Vessel Schedule (ต่อ) 
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รูปที ่5.13 แสดงผลลพัธ์การทดสอบ Migration หนา้ Edit เม่ือมีการใช ้Function Copy 
 

 
 

รูปที ่5.14  แสดงผลลพัธ์การทดสอบ Migration หนา้ Edit เม่ือมีการใช ้Export XML File 
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จัดท าเอกสาร Document  

- Individual Work List (IWL) 
 

 
 

รูปที ่5.15 แสดงตวัอยา่งเอกสารไฟล ์INDIVIDUAL WORK LIST 
 

- Migration ASP.NET to ASP.NET Core 
 

 
 

รูปที ่5.16 แสดงตวัอยา่งเอกสารไฟล ์Migration ASP.NET to ASP.NET Core 
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Support งาน และโปรเจคอ่ืน ๆตามทีไ่ด้รับมอบหมาย 

- เขา้ร่วมอบรม การพฒันาเวบ็ ASP.Net ใหก้บั มหาลยั เกษตร,บูรพา โดยเป็น TA ณ บริษทั A-Host 
จ ากดั 

- Support งาน project GPF ในส่วน ตรวจสอบ Security Code OWASP 
 

 
 

รูปที ่5.17 แสดงตวัอยา่งหนา้แรกของระบบ 
 
นอกจากน้ีการด าเนินงาน มีส่วนช่วยในการเสริมสร้างทกัษะอ่ืนๆท่ีจ าเป็นต่องานท่ีได้รับมอบหมาย 

รวมถึงการฝึกฝนทกัษะอ่ืนนอกเหนือจากทกัษะความรู้ทางภาษาคอมพิวเตอร์ อาทิเช่น ความรู้ดา้นธุรกิจ, 
การท างานเป็นทีม และท่ีส าคญัท่ีสุดคือการไดรั้บประสบการณ์ในการท างานจริงภายในบริษทั ท่ีจะใหแ้ง่คิด
ในการท างานในหลายๆมุมมอง ท่ีจะท าให้เห็นถึงปัญหาต่างๆท่ีอาจจะเกิดข้ึนไดใ้นการท างาน ซ่ึงนบัวา่เป็น
ประสบการณ์ท่ีดีในการน าไปใชใ้นชีวติการท างานจริง 
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5.2 แนวทางการแก้ไขปัญหา 
 

ปัญหาท่ีพบในระหวา่งการพฒันาระบบนั้นเป็นปัญหาในส่วนของโครงสร้างโปรเจคซ่ึงมีความซบัซ้อน
ซ่ึงมีการพฒันาหลายคนและมีระยะเวลาการพฒันาท่ียาวนานก่อนท่ีขา้พเจา้จะไดม้าเป็นส่วนหน่ึงในการ
พฒันาระบบในคร้ังน้ี ซ่ึงการพฒันาแต่ละคร้ังจะเกิดขอ้ผิดพลาด Bug เป็นธรรมดา ซ่ึงตอ้งช่วยเหลือกัน
ภายในทีม จะเห็นไดว้า่การพฒันาซอฟแวร์เป็นทีมนั้นไม่เพียงแค่มีความรู้เฉพาะทางอยา่งเดียวแต่ตอ้งมีความ
เขา้ใจในการท างานเป็นทีมดว้ย 

 
ปัญหาท่ีพบในระหวา่งการศึกษาวิธีการ Migrate จาก ASP.NET to ASP.NET Core นั้นส่วนใหญ่จะเกิด

จากการท่ีเทคโนโลยีใหม่และมีเน้ือหาทางวิชาการน้อย ไม่มีการรอบรับภาษาไทยมากนกั และปัญหาการท่ี
ระบบท่ีมีความแตกต่างในเร่ืองสภาพแวดลอ้มในการท างาน Framework ท าให้บางอยา่งไม่สามารถท าการ
โยกยา้ยจากระบบเก่ามาระบบใหม่ไดท้ั้งหมด ซ่ึงตอ้งมีการพฒันาเพิ่มเติมแต่งข้ึนมาเองแทนซ่ึงตอ้งท าให้มี
ลกัษณะใกลเ้คียงกนัและสามารถน างานไดค้ลา้ยเดิมมากท่ีสุด 

 
จากการทดสอบการพฒันาในคร้ังน้ีจะเป็นตวัตน้แบบและแนวทางในการตดัสินใจภายในแผนกว่าจะใช้
เทคโนโลยีใหม่น้ีอย่างไรในการพฒันา Web Application ว่าสมควรจะใช้ ASP.NET หรือ ข้ึน ASP.NET 
Core 
 

5.3 ข้อเสนอแนะจากการด าเนินงาน 
 

- ในการพฒันาระบบต่อจากผูอ่ื้นอาจจะตอ้งใชร้ะยะเวลานานพอสมควรในการศึกษาท าความเขา้ใจ
ระบบงาน 

- การพฒันาระบบต่าง ๆ ไม่วา่จะเป็นการใชง้าน Tools ภาษา ,เทคโนโลย ีFramework, lib ต่าง
จ าเป็นตอ้งมีทกัษะทางดา้นภาษาองักฤษเขา้มาเก่ียวขอ้งเพื่อใชใ้นการคน้หาความรู้อยูต่ลอดเวลา 
โดยเฉพาะอยา่งยิง่การเรียนรู้และแกไ้ขขอ้ผดิพลาด 

- การติดต่อประสานงานกนัภายในทีม เป็นส่วนส าคญัในการท างานจริง ท่ีจะส่งผลกระทบท่ีดีหรือไม่
ดีต่องานท่ีไดรั้บมอบหมาย ซ่ึงจะตอ้งอาศยัความร่วมมือของทุกฝ่าย ท่ีจะท าใหง้านส าเร็จลุล่วงไป
ไดด้ว้ยดี 
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- การท างานบางคร้ังตอ้งท าให้เสร็จภายในเวลาท่ีก าหนดสามารถท างานภายใตภ้าวะความกดดนัได ้
- ในการท างานจริง มีความจ าเป็นอยา่งยิง่ท่ีจะตอ้งศึกษาหาความรู้เพิ่มเติมอยูต่ลอดเวลา ซ่ึงความรู้

บางอยา่งไม่สามารถเรียนรู้ไดจ้ากในหอ้งเรียน 
- ความอดทนถือเป็นส่วนส าคญัอีกอยา่ง ท่ีท าใหก้ารท างานเป็นไปไดด้ว้ยดี และประสบผลส าเร็จ ซ่ึง

จะตอ้งข้ึนอยูก่บัรูปแบบของงาน, ระยะเวลาของงาน และผูร่้วมงานดว้ย 
- ความรับผดิชอบในหนา้ท่ี ถือเป็นส่ิงท่ีดีอยา่งมากท่ีไดรั้บจากการท างานจริง ซ่ึงสามารถน ามาใชใ้น

การพฒันาตนเองไดอ้ยา่งดีเยี่ยม ท าใหมี้ความรับผดิชอบมากข้ึน และสามารถตดัสินใจไดเ้อง
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ประวตัผิู้จดัท าโครงงาน 

 
 

ช่ือ – สกุล   นายธราเทพ เชิงชยัภูมิ 
 

วนั เดือน ปีเกดิ   15 มิถุนายน 2539 
 

ประวตัิการศึกษา   

ระดบัประถมศึกษา  โรงเรียนบางบวั (เพง่ตั้งตรงจิตรวทิยาคาร) 
      
ระดบัมธัยมศึกษา  โรงเรียนสารวทิยา 

     
ระดบัอุดมศึกษา   คณะเทคโนโลยสีารสนเทศ สาขาเทคโนโลยสีารสนเทศ 

   สถาบนัเทคโนโลยไีทย-ญ่ีปุ่น 
     
 

ทุนการศึกษา  - ไม่มี -  
 

ประวตัิการฝึกอบรม Programming Contest ACM-ICPC 2015 (IBM, Chula Engineering) 
JAXA Space and Technology (Japan Aerospace Exploration Agency) 
Financial Cybersecurity Boot Camp #1 (ETDA | Electronic Transactions 
Development Agency (Public Organization)). 
Training Pre-Cooperative Education (A-Host Company limited) 

     
       

    
ผลงานทีไ่ด้รับการตีพมิพ์    - ไม่มี - 
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